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Limited Warranty, Limitations Of Liability And Restrictions 
Geophysical Survey Systems, Inc. hereinafter referred to as GSSI, warrants that for a period of  
24 months from the delivery date to the original purchaser this product will be free from defects in 
materials and workmanship. EXCEPT FOR THE FOREGOING LIMITED WARRANTY, GSSI 
DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. GSSI's obligation is limited to 
repairing or replacing parts or equipment which are returned to GSSI, transportation and insurance pre-
paid, without alteration or further damage, and which in GSSI's judgment, were defective or became 
defective during normal use. 

GSSI ASSUMES NO LIABILITY FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES OR INJURIES CAUSED BY PROPER OR IMPROPER OPERATION 
OF ITS EQUIPMENT, WHETHER OR NOT DEFECTIVE. 

Before returning any equipment to GSSI, a Return Material Authorization (RMA) number must be 
obtained. Please call the GSSI Customer Service Manager who will assign an RMA number. Be sure to 
have the serial number of the unit available. 

FCC Class A Compliance 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation. 
Warning: Changes or modifications to this unit not expressly approved by the party responsible 
for compliance could void the user’s authority to operate the equipment. 
Note: This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment or residential installation. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the introduction manual, may 
cause harmful interference to radio communications. However, there is not guarantee that 
interference will not occur in a particular installation.  
Shielded cables must be used with this unit to ensure compliance with the Class A FCC 
limits. 

Canadian Emissions Requirements 
This Class A digital apparatus complies with Canadian ICES-003. 
Cet appareil numerique de la classe A est conforme a la norme NMB-003 du Canada. 

Notice 
Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) 
this device must accept any interference, including interference that may cause undesired operation of the 
device. 
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Chapter 1: Introduction 
This manual is designed for both the novice and experienced user of ground penetrating radar. It is 
intended as both a reference and a teaching tool and it is recommended that you read the entire manual, 
regardless of your level of GPR experience. For information about GPR theory, please see the list of 
general geophysics references that can be found in Appendix F.  

If you experience operation problems with your system, GSSI Tech Support can be reached 9 am-5 pm 
EST, Monday-Friday, at 1-800-524-3011, or at (603) 893-1109 (International). Also be sure to see the 
GSSI Support website at support.geophysical.com. Note that you do not need to type in www. The 
support site has a wealth of information, including software and manual updates, as well as a frequently 
asked questions (FAQ) page. 

Unpacking Your System 
Thank you for purchasing a GSSI SIR® 20 (hereafter referred to as SIR 20). A packing list is included 
with your shipment that identifies all of the items that are in your order. You should check your shipment 
against the packing list upon receipt of your shipment. If you find an item is missing or was damaged 
during the shipment, please call or fax your sales representative immediately so that we can correct the 
problem. 

You may have purchased your SIR 20 as part of a pre-configured system. If you have purchased the 
SIR 20 separately, your SIR 20 system contains the following items: 

 1 - Digital Control Unit MF-20. This is the blue box with the fan on the side and the connectors in the 
back. 

 1 - Panasonic ToughBook® computer. This will be mounted to the MF-20 box. 

 1 - ToughBook CD Drive. 

 1 - RADAN™ Main and 3D QuickDraw software package. This is pre-loaded on your ToughBook. 

 1 – DC Adaptor for use with a car cigarette lighter attachment  

 1 - AC Adaptor 

 1 - Operation Manual  

 1 - Transit Case. 

Your choice of antenna, cables, and portable battery packs is available for an additional purchase. 

Warning: Do not load any additional software on to your SIR 20 laptop. Loading additional software 
onto your GPR system may cause system failure. System failure due to the loading of unauthorized 
software is not covered by warranty. 

http://support.geophysical.com/
http://www./
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General Description 
The SIR 20 is a high-speed, powerful, multi-channel ground penetrating radar system that is ideal for a 
wide variety of applications. The various components of the SIR 20 are described below. 

External Features 
The major external features of the SIR 20 are the MF-20 mainframe, laptop, mounting plate hardware, 
network shield and mainframe connector panel. There is also an AC power adaptor and the DC power 
adaptor. The DC power adaptor has a cigarette lighter attachment on one end and the square, two-hole 
power connector on the other. 

Please refer to the image below and note the different external features. 

 

 
Figure 1: Major external features (May vary depending on Toughbook model). 

The SIR 20 is designed to be used in a variety of field configurations. While it is often preferable to leave 
the laptop attached to the system as one whole unit, you may sometime wish to separate the computer and 
the MF-20 control box. You will first need to loosen the thumbscrews on the front of the mounting plate. 
This will allow you to slide the clamp brackets away from the handle of the laptop. You will then remove 
the network shield and disconnect the power and network cables. You will then be able to lift the laptop 
off of the mounting plate. 

Helpful Hints: Be sure to periodically check the mounting plate thumbscrews to make sure that they stay 
tight. Always leave the network shield in place when the laptop is mounted on the MF-20. 



Geophysical Survey Systems, Inc. SIR® 20 
 Manual 
 

MN92-078 Rev F 3 

Connector Panel 
Turn the SIR 20 around to look at the back of the unit. You will notice that the mounting hardware is 
designed to allow you access to the standard computer connectors on the back of the laptop. You can use 
these connectors just as you would use them on a regular laptop computer. If you would like to connect a 
projector, for example, use the VGA port. 

 
Figure 2: Connectors under network cable shield. 

The laptop’s USB port can be accessed opening the protective door at the back of the laptop. The 
connector panel on the back of the MF-20 is detailed below. 

 
Figure 3: MF-20 connector panel. 

1 This port accepts the connector from the Smart Lead/Acid battery (part # FGMOD1218S3). The 
metal clip is designed to fit over the battery connector and ensure a tight connection. 

2 This port accepts the standard Lead/Acid battery (part # FGMOD1218S2), the AC power supply 
connector, or the DC power supply connector. The metal clip is designed to fit over the device 
connector and ensure a tight connection. 



Geophysical Survey Systems, Inc. SIR® 20 
 Manual 
 

MN92-078 Rev F 4 

3 Indicator lights: The top light will flash amber to indicate that there is good communication 
between the laptop and the MF-20. This light will not be lit constantly, but will only flash during 
active communication (such as taking data). The bottom light is the MF-20 power light. This will be 
lit (green) whenever the MF-20 is on. If you lose power, your laptop will switch to its onboard 
battery, but the MF-20 power light will go off. 

4 Sync connector: This is reserved for application requiring multiple SIR 20s to be linked together. 
This feature is currently unavailable. 

5 SIR 20 power converter: The power converter is used to keep the laptop battery charged. If the 
SIR 20 is plugged into a power source, there will be a green light on the front of the converter. This 
light will be lit even if the SIR 20 is turned off. 

Helpful Hint: If your SIR 20 is plugged into a reliable power source but your laptop battery does not 
appear to be charging, you should check the two plugs in this converter to make sure there is a good 
connection. Also check the 15 amp fuse. 

6 Marker connector: This is a 2-pin connector used to attach a remote marker trigger to the system. 
The marker trigger would be used to indicate points of interest in the data. 

7 Survey wheel connector: This is a 4-pin connector used to attach a survey wheel or DMI (distance 
measuring instrument). If you are using your SIR 20 for a pavement mapping application, this is 
where you will plug in the lead from your wheel-mounted DMI. 

8 Transducer 1 port: This port is hardware channel 1 and accepts a 19 pin GSSI standard control 
cable from your antenna. To connect the control cable, line up the 5 indents on the connector with the 
5 keys on the male end of the control cable. Then tighten the screw collar on the control cable until 
the collar covers the red line on the SIR 20 connector. Only hand-tighten connections. If you are only 
using one antenna, connect the antenna to the transducer 1 port. 

9 Transducer 2 port: This port is hardware channel 2 and accepts a 19 pin GSSI standard control 
cable from your antenna. To connect the control cable, line up the 5 indents on the connector with the 
5 keys on the male end of the control cable. Then tighten the screw collar on the control cable until 
the collar covers the red line on the SIR 20 connector. Only hand-tighten connections. 
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Hardware Setup 
To setup your GPR system for data collection, you will need the following items: 

• SIR 20 

• an antenna 

• a control cable 

• a power source (AC, battery, or DC) 

If you are using a SIR 20 as part of a RoadScan™ system, see Appendix A. If you are using your SIR 20 
on a survey cart, please see the survey cart manual for instructions on hardware setup. 

1 Remove your SIR 20 from the transit case and place on a flat surface. Allow for some airflow around 
the cooling fan on the side of the MF-20.  

2 Connect your antenna to the SIR 20 with a control cable. Ensure that the connection is hand tight. 

3 If you are using a survey wheel, connect the survey wheel lead to the survey port on your antenna 
housing.  

4 Connect your SIR 20 to your power source.  

5 Turn on the SIR 20 by turning on the laptop computer. The laptop will boot up and the cooling fan 
will come on. To turn the SIR 20 off, shut down the laptop like you would shut down any Windows 
computer.  

 
Figure 4: The On Button. 
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Chapter 2: Setting Up your System for 
2D Data Collection  

After your SIR 20 boots up, you will see a Windows desktop with a number of shortcuts on it.  
A base SIR 20 system includes one shortcut icon that will open the data collection program  
(SIR 20) and one icon that will open the data processing package (RADAN).  

 
Figure 5: SIR 20 Desktop (with StructureScan™ Icons). 

You will see five additional shortcuts with a GPR profile outline: RADAN, SIR 20, SS Linescan, 
Structure Scan, and Optical Scan. RADAN is only for data processing. The other four open separate data 
collection programs. SS Linescan, Structure Scan, and Optical Scan are specifically designed for shallow 
scanning of concrete structures with very high frequency antennas. Operation of these programs will be 
discussed later in Chapter 4. SIR 20 is the general purpose data collection program. 
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System Parameter Setup 
This section will take you through the initial program setup for data collection.  

Create Folders 
The SIR 20 is capable of collecting an enormous volume of data. The first important task of the GPR user 
is to find some way to keep this data organized. The SIR 20 uses the hard disk of the ToughBook 
computer to store data. Before beginning each project, you may wish to create a new folder on the 
laptop’s hard disk. This folder can have any name associated with it, so you can name it by date, customer 
name, or job number.  

Creating a new folder in Windows is easy; just follow the following steps: 

1 Click the Start button on the Windows toolbar at the bottom of the screen. This will open a big pop-
up menu. 

2 Find the option for My Computer and click it. This will open a window showing any disk drives that 
you have installed. 

3 Find the Hard Disk Drives section and double-click Local Disk (C:). This will open a window 
showing all of the folders that you have stored. You will see six choices at the top of the screen. They 
say: File, Edit, View, Favorites, Tools, Help. Click on File. 

4 Move the arrow down to New and then over to Folder. Click on Folder. You will see that Windows 
creates a new folder on your C: drive. You will need to rename this. 

5 Type in a new name and press Enter on the keyboard. 

6 Double-click the little picture of the folder that you just made to go inside it. Repeat Steps 4 and 5 to 
create a new folder inside of the one you are in. Call this one Output. We will look at why you need 
an output folder later. 

7 Now you are done. Go back to the Desktop and double-click the SIR 20 icon. This will open the 
SIR 20 program.  

Note: You will see a RADAN splash screen when you open the SIR 20. This is because the SIR 20 
program is a module that runs in RADAN. Click anywhere on the screen to make the image disappear. 
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Set Program Defaults 
Now you will need to tell RADAN about the folders you created and set some other parameters. Double-
click the SIR 20 shortcut on the Windows desktop. We will start from the initial RADAN/SIR 20 screen. 

 
Figure 6: SIR 20 initial screen. 

1 Find the View pull-down menu at the top of the screen and click on it. Look for the Status Bar and the 
Customize options. 

2 Make sure that there is a check next to the Status Bar. If not, move the arrow down to highlight it and 
click on it. 

3 Next click Customize. You will see a window with four tabs at the top. 

 
Figure 7: Customize window. 

4 Directories: Set working directories. 

• Click the Source button. You will see a window pop-up with a list of folders that are on your 
computer. If you type in a new complete path beginning with C:\ then RADAN will also create a 
new folder for you. 

• Find the folder that you created in the previous section and click the picture of the little folder to 
open it. Then click OK.  

• Do the same for the Output folder.  
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• We need to have a Source and an Output folder because the SIR 20 will store different parts of 
your data in different places. It does this so that parts of data that you don’t want to get 
overwritten by accident (like project info files) are protected in the Source folder while the 
system stores other files in the Output (like collected and processed data). 

5 Appearance: Set your viewing preferences under Appearance.  

• This tab controls the look and feel of the software. If you like to see Large Buttons on the screen 
for example, make sure that that choice is checked. These changes will take effect the next time 
that SIR 20/RADAN is started. 

6 Linear Units: This sets your units of measurement and the order of magnitude of those 
measurements. Choose whatever you feel is appropriate for your application. 

7 SIRVEYOR: If you are using a GPS with your system, click the SIRVEYOR tab to configure the 
GPS. Instructions on this can be found in the GPS integration chapter. 

8 Click OK once you are satisfied that you have set up the system to your desired parameters. 

Setting Up your System for 2D Data Collection 

Projects and Profiles: How the SIR 20 Collects Data 
The SIR 20 collects data files by using a Project file as a model. The project file is created when you enter 
collection parameters. Each time you tell the SIR 20 to collect a new data file, it will examine the 
parameters you provided in the project file and collect data with those settings. Let’s first look at the three 
main file types that are important in 2D data collection: Project, Data, and Macro files. As you create 
these different file types, try to keep a notebook with their names and your job information. That way, 
you will know what all of these file types mean when you go to review your work. All of these files will 
be stored in the folder that you created in the previous section. 

Project Files have the extension *.rpj. Their function is to serve as a list of instructions to the SIR 20 so 
that the system knows how to collect your data files and what to name them. The name of each data file is 
taken from the name of your project file. For example, if you call you project file Test.rpj, you data files 
will be named Test001, Test002, etc. You should keep your project file names as short as possible (less 
than 8 characters). RADAN will only use the first eight characters of your project file name for each data 
(*.dzt) file name. This can lead to confusion if your project file names are too long. 

Data Files have the extension *.dzt. These are your actual radar data profiles. When you open a data file 
in RADAN, you are opening a *.dzt file. The data file takes it name and data acquisition parameters from 
the project file. These files contain a File Header as well. The file header contains all of the acquisition 
parameters settings used to collect a specific *.dzt file 

Macro Files have the extension *.cmf. These files contain specific settings that your system needs for 
collection. You create the macro file during the project file setup process and the macro file is then 
attached to the project file. The SIR 20 will use your project file and your macro file as a list of 
instructions to collect your data files. This information is stored in the File Header. 
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Working with the Master Project File (Optional) 
The SIR 20 incorporates a Master Project collection scheme that is intended to streamline data collection. 
It is intended for use in application where all data area collected with common settings. The master 
project is created by you just like any other project, but it is saved into the Master Project file in the 
SIR 20 program. It is then automatically recalled at the beginning of each collection. Upon recalling the 
master project, you will have the opportunity to change its name. This will not re-name the master project 
file, but will become the root name of all of the data files that you collect going forward.  

To use: 

1 Create a data collection project as described in the previous section. Take note of the location where 
that project is saved. 

2 Minimize or close the SIR 20 collection program and copy that project file and the macro to: 
C:\Program File\GSSI\RADANXP\Master Project. Make sure the macro copies as well. For example, 
if you called your project TEST, you will need to copy TEST.RPJ (project file) and TEST.CMF 
(macro) to the master project file. You can rename it at this point if you wish, but make sure both files 
have exactly the same name. 

3 When you wish to use the master project, open the SIR 20 collection program and click the Run 

Master Project icon located at the bottom-left of the screen.  

4 Enter in a new name if you wish. The data files will be saved to the working directory. 

5 Collect data as normal. 

The File Header 
A file header is an integral part of each data file. It contains all of the radar system acquisition parameters 
at the time of data collection. The file header comprises the first 1024 bytes per channel of a *.dzt file. 
The primary purpose of the File Header is to record and preserve the data acquisition parameters used to 
collect the data.  

While all of the entries in the Header may seem intimidating at first, after you have worked with GPR 
data for some time, you will find yourself gaining a full understanding of all of the different pieces of 
information that it contains. Some of this information can be edited after collection to correspond to post-
processing changes or for report generation. In addition, the file header can include field information such 
as location, client, date, job number, surface material, or other information useful in characterizing a site.  
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Figure 8: File Header Dialog Box. 

File header parameters include: file name, antenna frequency, range, transmitted pulse position, channel, 
samples/scan, bits/sample, scans/unit, units/mark, dielectric constant, and approximate depth range. 
Scans/unit will be English (Imperial) or Metric units depending on what linear units you selected in  
View > Customize. 

Collection Parameters 

 
Figure 9: The Configuration Window. 

Your SIR 20 can be used for many different applications. Because of this, you should have a full 
understanding of how different configuration settings should be applied to each type of survey. You will 
see the Configuration Window during a new collection project setup, but it is useful to explain these 
parameters first. 
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1 Config(uration) Type: This allows you to access a number of pre-defined settings for common 
applications. These include: structure concrete scanning, utility locating, bridge assessment, highway 
survey, and geophysical surveys. If you application fits into one of these broad categories then you 
can select one of these for a quick, easy setup.  

• If your application is not listed, then you should select Custom window 1 and 2 and set up your 
antenna manually. A list of appropriate default settings can be found in the back of this manual. 

2 Config(uration) Name: After selecting a Config type in window 1, you can select the antenna that 
you are using. This makes for easier setup of antenna-specific parameters such as filter settings and 
time range.  

• If your antenna is not listed, then you should select Custom in window 1 and 2 and set up your 
antenna manually. A list of appropriate default settings can be found in the back of this manual. 

3 Number of Channels: The SIR 20 can operate one or two data collection channels simultaneously. 
If you want to run two antennas or to use one as a transmitter and the other as a receiver for bi-static 
or Common Depth Point (CDP) profiling, you should select Custom in windows 1 and 2 and then 
select 2 channels here. You will need to have two similar antennas and two control cables of the same 
length if you intend to use two hardware channels for bi-static or CDP data collection. You will 
further define the two channels in windows 10 and 12. 

4 Samp/Scan: The default sample per scan setting is 512. This is the number of samples per scan that 
the SIR 20 will use to digitize the trace. This number must be greater than 10 times range/antenna 
pulse width to avoid aliasing. Antenna pulse widths are listed in the antenna setup section at the back 
of this manual. Sampling densities available are: 128, 256, 512, 1024, and 2048. 

5 Scans/Sec: This is the number of individual data scans that your system is collecting every second.  

• If you are using the free run (time based) collection mode, then this number, along with the 
transmit rate, your survey speed and the type and width of any horizontal filter selected 
determines your scan density along your profile.  

• If you are collecting data with a survey wheel, then this number, along with the transmit 
frequency and scans per unit distance (window 7) determines your maximum survey speed. For 
example, if your system is taking 100 scans/sec and you want to collect 10 scans/ft, then the 
maximum speed you can go is 10 ft/sec. The maximum scan/sec is automatically calculated by 
the SIR 20 and is derived from the relationship between samples/scan and the systems transmit 
rate (window 10). This estimated value can be affected by a number of timing parameters. These 
effects are seen with higher (greater than 200 KHz) transmit rates. 

6 DielConstant: Short for dielectric constant. The range of values for the dielectric constant of 
materials (including air and water) are 1-81. This will allow the SIR 20 to display a linear depth scale 
as the vertical scale rather than time. If you know the dielectric constant of the material you are 
scanning through, you should enter it. Otherwise, leave this set to 1. This parameter has no effect on 
the actual depth of the scan. 
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7 Scans/ft(m): This is the number of scans per distance unit that you are collecting. If you are using a 
survey wheel, then this is the actual number of scans per distance along your profile. This number 
should be set as high as practical. The higher the number of scans per unit distance, the larger the data 
file size and the slower the data collection speed. If you are collecting free run data, then this number 
is for note taking purposes only. If you are collecting survey wheel data and any horizontal filters 
and/or static stacking filters are enabled, the filter value will affect the number of scans per unit 
distance collected. For example, if you set the scans/ft to 20 and you have a stacking filter set to stack 
4 scans, the output file will have 5 scans per foot (20/4), not 20 scans/ft. 

8 Ft(m)/Mark: When used in the Survey Wheel mode, the SIR 20 will put a mark into the data at user 
specified intervals. A mark is a small vertical line that is superimposed over your data window and is 
intended to allow you to easily ‘eyeball’ distance across your profile. The value selected is a matter of 
personal preference. 

9 Auto Gain Level: Typically set to 0.5. This controls the SIR 20 auto gain servos. When you initialize 
the antenna, the SIR 20 runs an algorithm on the received signal and decides how much gain 
amplification to apply to the signal. The auto gain level defines how strong the gained signal should 
be relative to the recordable dynamic range (+/-32767 for 16-bit data). A value of 0.5 means that the 
strongest gained sample in any given gain segment will be 50% of the total dynamic range. If you 
believe that you have targets or reflectors with highly variable amplitude and are afraid of clipping, 
than you should set this value to 0.25 so that there is ‘more headspace’ in the dynamic range to record 
sudden large changes in signal amplitudes. 

10 Transmit Rate/Channel Selector: This allows you to set different transmit frequencies for your 
antennas. The correct transmit rates can be found in the antenna parameter section at the back of this 
manual. Typical transmit rates for GSSI 51XX series antennas are 100 KHz. Older or lower 
frequency antennas may have to be set lower. You can also change the channels that those antennas 
are run on. For example, if you have two antennas and would like to transmit on one and receive on 
the other, then you can enter these parameters here. 

11 Antenna Calibration File: This option is used exclusively for RoadScan work with high frequency 
horn antennas. Consult the RoadScan application manual for details. 

12 SIRveyor: This is a representation of the connectors on the back of the SIR 20. This allows you to 
visually double check that you have the correct antenna plugged into the correct channel port. 
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Data Collection Methods 
There are three ways that you can collect GPR data: In Survey Wheel mode, i.e. scans per unit distance, 
Free Run mode, i.e. scans per second, and Point Mode, i.e. one scan per each discrete antenna position. 

Survey wheel data collection means that you have a survey wheel distance encoder, DMI, or a 
StructureScan minicart. These devices allow you to collect data at a specific even scan spacing so that 
your data is collected with a linear horizontal scale, no matter what speed you are collecting data at. This 
is the easiest, most accurate way to collect data and is recommended for most users. This mode of data 
collection is required for the RADAN Migration routine and other signal processing functions to operate 
correctly. 

Free run data is collected without the benefit of a survey wheel. Your data does not have position 
information unless you are also using a GPS. The SIR 20 will collect a certain number of scans per 
second and it is up to you to move your antenna over your survey surface at a constant rate. If you collect 
free run data you should lay out a tape measure along your survey line and click your marker button 
whenever you antenna passes a measured grid point (e.g. every 5 feet). This will allow you to determine 
the approximate location of reflectors in your data. You can perform distance normalization in RADAN 
on this type of data later to convert the horizontal scale to an approximate linear scale. See the RADAN 
User’s Manual for details on distance normalization. 

Point mode data is collected one scan at a time with the antenna placed at a discrete location along a 
profile line. After a scan is collected, the antenna is picked up and moved to a new location for the next 
scan. This is commonly done with large, low frequency antennas, in areas with rough surface conditions 
or rugged terrain, or when collecting a common mid-point stack with two antennas. 

Now let’s look at how to set up for each of these modes.  

Survey Wheel Controlled Collection 

1 Create a new collection project by going to File > New or clicking the New Project button  on the 
collection controls bar. This will open a window with the heading Create New Data Collection 
Project (Figure 10). 

 
Figure 10: Project File Name box. 
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2 Enter a project file name in the white box that is labeled File Name: Remember to keep the name less 
than 8 characters. Alphanumeric values are acceptable. Do not use any symbols.  

• We are only collecting 2D data now, so do not click the button that says Collect 3D Data Set.  

• Click Next >. This will open a new window with the heading Review Project Information (Figure 
11). 

 
Figure 11: Project Information dialog box. 

3 Enter information to describe your project area. You can give the project a Title, Start/Finish time and 
add Notes.  

• Note the gray button for Output Path. This is the location where the SIR 20 will store your data 
files. This location was set by you in View > Customize.  

• All data entry on this screen is optional. If you do not wish to add notes, click Next >.  
A window will open with the heading Data Collection Mode (Figure 12). 

 
Figure 12: Data Collection Mode window. 
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4 This window provides you with a choice of the three ways you can collect radar data. We will discuss 
Free Run and Point Mode later, but for now click the Survey Wheel button.  

• Notice the button for Enable GPS. You can collect GPS data along with your survey wheel, free 
run, or point data. See the section on using a GPS for details on setup.  

• After you click Survey Wheel, you should see a button for Calibrate SW. Click on it. 

5 You will see a window pop up with the heading Survey Wheel Calibration (Figure 13). This is where 
you enable the specific survey wheel device you are using with the SIR 20 and determine how many 
internal ‘ticks’ per selected unit of distance.  

 
Figure 13: Survey Wheel Calibration dialog box. 

• If you have a StructureScan minicart, click on the image of the cart that you have.  

• If you have an Optical cart, click the image of the blue minicart.  

• If you have a different survey wheel device than the ones pictured, then you must calibrate your 
survey wheel.  

• Once calibrated, click Save > Next >. This will open a window with the heading Configuration 
(Figure 14). You must calibrate your survey wheel. Failure to do so will result in an incorrect 
horizontal scale on your profiles. 

 
Figure 14: Configuration window. 
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6 This screen enables you to select/change your data acquisition parameters. For most applications the 
default settings are adequate. To access settings for different applications click the small arrow in the 
Config Type (1) option.  

• You will see a broad list of application categories. Choose the one that best describes your 
application.  

• For example if you are scanning a concrete slab to find reinforcing bars, choose CONCRETE. 
Then choose your antenna type under Config Name (2). An X after the configuration name is 
used to denote use of an antenna that has its dipoles oriented perpendicular to the normal survey 
direction. Common data collection parameters will be automatically set. 

7 Check to make sure that Scans/ft (7) is adequate for your application. Generally, the more scans per 
unit that you collect, the slower your collection speed, the larger your data file and the more stretched 
your file will appear. When you are finished, click Next >. 

8 The next window (Figure 15) will ask you to either create a new macro, or attach one that you have 
already created. A macro is nothing more than a saved list of data collection parameters. These 
parameters include: filters, time range and gain settings. These parameters will vary from job to job, 
so it is possible that you will have many different macros for different survey objectives. Common 
parameters for your antenna will be selected automatically based on the Config Type and Config 
Name that you chose in Step 6. 

 
Figure 15: Attach a Macro or Create a New One. 

• There are no pre-saved macros on the system, so if you are using your SIR 20 for the first time 
you will need to create one. Click the button for Create New Macro and click Finish. The antenna 
will initialize, you will see a clock counting a few seconds and then the following window will 
pop-up: 
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Figure 16: The Setup Screen. 

9 This window will allow you to further customize your data acquisition parameters. The window is 
divided into two main areas.  

• The top 2/3 of the window shows the data display as O-scope and Linescan.  

• The bottom 1/3 is reserved for parameter selection pop-up windows. These parameter selection 
windows can be accessed by clicking on one of the blue and yellow acquisition parameter 
controls at the bottom of the screen.  

• You can also check the file header by clicking on the File Header icon.  

Position/Range   
The first collection parameter button is for Position/Range. This controls the length of the time (in 
nanoseconds) that the system will acquire data. The default vertical scale is two-way travel time. The 
larger the value that you set for time range, the deeper your SIR 20 will record data. This (generally) 
translates to scanning deeper, however, total depth of penetration is a function of both the conductivity 
(σ’) and permittivity (ε’) of the media, so the range and depth are not directly equivalent.  

The Auto Position Servo and Position correction control enable the user to adjust the direct coupling 
pulse (i.e., the transmitted pulse) of the antenna to ‘zero’ time, or to adjust the direct coupling pulse up or 
down in the selected time range window. You will note that with the auto position servo ‘ON’ the 
transmitted pulse is set several nanoseconds below the top of the O-scope display. The Auto Position 
Servo automatically sets the transmitted pulse ‘down’ in the time range window approximately 10% of 
the value entered for the range e.g. if the time range is set at 50 ns, the transmitted pulse will be set 5 ns 
below ‘zero’. This is done to insure that the entire transmitted pulse is recorded.  

If this function is inadvertently turned off during system configuration, the transmitted pulse (zero time) 
may not be present in the time range window. If this occurs, the data will be useless as you will have no 
zero time reference form which to measure time/depth.  

GSSI recommends that you leave the Auto Position servo ON until you are familiar with the effects of 
moving the signal up or down in the time range window. Please note that the ‘zero’ time on the SIR 20 is 
indicated by the value of 100. This value is arbitrary and has to do with the delay time of transmit and 
receive signals within the electronics of the system. This value does NOT affect the stored value of the 
range. 
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Gain   
The second button controls the Time-Variable-Gain (TVG). Gain is signal amplification used to 
compensate for the natural effects of signal attenuation. As the transmitted signal passes through a 
material, it will weaken (attenuate) as the material absorbs some signal. Gain amplifies that signal after it 
is received to compensate for signal losses and make weaker reflectors easier to see. No additional energy 
is sent out of the antenna.  

The Gain function operates at a number of linearly distributed points along the time range. The Auto Gain 
Servo automatically sets the gain of the system based upon the received signal from the antenna at the 
point where the antenna is located when the servo is enabled. At large sites it may be necessary to briefly 
scan the site to decide if the Auto Gain Servo gain values are too high or too low.  

In either case, you should adjust the gains manually. You cannot set the exact time of a gain point; 
however, you can manipulate the number of gain points so as to ‘position’ a gain point near a particular 
time range (or a particular reflector). You can then adjust the amount of gain applied.  

Gain should never decrease with depth. Each successive gain point should be greater than or equal to the 
previous. Be careful not to apply too much gain. This will lead to a phenomenon known as ‘clipping’. 
Clipping will limit the data and will cause you to lose valuable information and make it much more 
difficult to identify targets in the data. In addition, RADAN functions such as vertical and horizontal 
filtering, FFT filtering, Spectrum transformation and Hilbert envelope processing will not operate 
correctly on the data. If you prefer to leave the gain setting up to the SIR 20, make sure that Auto Gain 
Servo is enabled. 

 
Figure 17: Example of clipped versus acceptable data. 

Filters and Stacking   
The next three buttons control filters and stacking. These are useful for removing both high and low 
frequency noises, as well as horizontal noise known as ‘ring-down’ in the data. Horizontal noise is an 
artifact caused by variability in antenna coupling or high surface permittivity/ conductivity. A background 
removal filter of suitable length will remove these artifacts.  

Many of the filter parameters are antenna-specific and are set automatically for the antenna that you chose 
in Step 6. If you are using an antenna other than one listed in the default configuration you should alter 
the filter settings for the antenna being used. Consult your antenna documentation for correct settings. 
GSSI recommends that inexperienced users accept the default settings. 
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Any changes you make to the collection parameters are automatically stored in the macro file. After you 

are satisfied with the collection parameters, click the green arrow  to begin collection. The Linescan 
profile will resize to fit the whole screen. 

During Collection 
• During survey wheel collection, you can stop moving at any time. Since the 

survey wheel controls data collection, if the wheel is not turning, the SIR 20 
is in pause mode. 

• Clicking the marker button on your antenna tow handle or the down arrow 
on the laptop keyboard will put a mark (dashed line) in the data. This is 
useful for marking permanent surface features of interest on your survey 
surface. 

• You can end the survey by clicking the appropriate button on the collection 
toolbar. You can also close (and save automatically) the file by holding down the antenna tow 
handle marker button for 5 seconds. 

• To collect another profile with the same settings, click the Run Project button (green square). 

Time-Based (Free Run Continuous) Data Collection 
The setup procedure for a time-based collection is very similar to a survey wheel-controlled collection. 
The SIR 20 is configured to collect a certain number of scans per second and it will be up to the operator 
to move the antenna over the survey surface at a reasonable speed. If you move slowly you will collect a 
large number of scans per distance, and if you move your antenna rapidly you will collect a small number 
of scans per distance. 

1 Create a new collection project by going to File > New or clicking the New Project button  on the 
collection controls bar. This will open a window with the heading Create New Data Collection 
Project (Figure 18). 

 
Figure 18: Project File Name box. 
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2 Enter a project file name in the white box that is labeled File Name: Remember to keep the name less 
than 8 characters. Alphanumeric values are acceptable. Do not use any symbols.  

• We are only collecting 2D data now, so do not click the button that says Collect 3D Data Set.  

• Click Next >. This will open a new window with the heading Review Project Information  
(Figure 19). 

 
Figure 19: Project Information dialog box. 

3 Enter information to describe your project area. You can give the project a Title, Start/Finish time and 
add Notes.  

• Note the gray button for Output Path. This is the location where the SIR 20 will store your data 
files. This location was set by you in View > Customize.  

• All data entry on this screen is optional. If you do not wish to add notes, click Next >.  
A window will open with the heading Data Collection Mode (Figure 20). 

 
Figure 20: Data Collection Mode. 
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4 Even though the Configuration Window will show options for Scans/Ft, that parameter has no affect 
on time-based data collection. The most important collection parameter is Scans/Sec. This is the 
number of scans that your SIR 20 will record every second. The most common method for 
determining the correct number is to figure out how many scans per unit distance you want and 
compare that to a comfortable walking pace. For example, 12 scans per foot is desired and the 
operator will walk at 3 feet per second. The Scans/sec should then be set at 36. 

5 Once you have made changes to the collection parameters, follow Steps 8 and 9 of the Survey Wheel 
Controlled Collection setup. 

During Collection 
• During time-based collection, you can stop moving at any time, but the 

SIR 20 will continue to collect data. You can interrupt data collection by 
clicking the pause button on the collection toolbar, or by holding down the 
marker button on the antenna tow handle for at least 3, but no more than 5 
seconds. 

• Clicking the marker button on your antenna tow handle or the down arrow 
on the laptop keyboard will put a mark (dashed line) in the data. This is 
useful for noting features of interest at your survey site and for marking the 
linear distance surveyed. 

• You can end the survey by clicking the appropriate button on the collection toolbar. You can also 
close and save the file by holding down the antenna tow handle marker button for 5 seconds. 

• To collect another profile with the same settings, click the Run Project button (green square). 

Point Mode Data Collection 
This data collection mode is very similar to survey wheel and time-based collection. Point data mode 
collection is usually performed with large, low frequency antennas or with two similar antennas in a bi-
static configuration. When two antennas are used, one acts as a transmitter and one as a receiver.  

Typically point data is collected at discrete stations spaced at a constant separation which will produce a 
file with a linear horizontal scale. Care must be taken when selecting the scan spacing. If too small a 
number of traces per unit distance are collected, the profile will be under-sampled and you could miss 
targets of interest. If too large a number of traces are selected, the data file will be over-sampled. This will 
generate a very large file and can significantly increase in the time to collect the file. 

1 Create a new collection project by going to File > New or clicking the New Project button  on the 
collection controls bar. This will open a window with the heading Create New Data Collection 
Project (Figure 21). 
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Figure 21: Project File Name box. 

2 Enter a project file name in the white box that is labeled File Name: Remember to keep the name less 
than 8 characters. Alphanumeric values are acceptable. Do not use any symbols.  

• We are only collecting 2D data now, so do not click the button that says Collect 3D Data Set.  

• Click Next >. This will open a new window with the heading Review Project Information  
(Figure 22). 

 
Figure 22: Project Information dialog box. 

3 Enter information to describe your project area. You can give the project a Title, Start/Finish time and 
add Notes.  

• Note the gray button for Output Path. This is the location where the SIR 20 will store your data 
files. This location was set by you in View > Customize.  

• All data entry on this screen is optional. If you do not wish to add notes, click Next >.  
A window will open with the heading Data Collection Mode (Figure 23). 
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Figure 23: Data Collection Mode. 

4 Even though the Configuration Window will show a parameter value for Scans/Ft, this parameter has 
no affect on actual linear distance collected in point data. 

 
Figure 24: Configuration window. 

You may wish to collect data in bi-static mode with two similar antennas. Determine which one is to be 
the transmit antenna and which is to be the receive antenna and enter that information in the channel 
selection area (10). Make sure that each antenna is plugged into the correct port on the back of the  
SIR 20. Make sure that when you are collecting data using two separate antennas in bi-static mode that 
the control cables for each antenna are the same length. If the antenna cables are of different lengths, the 
transmit/receive synchronization of the system will be incorrect and the system will collect useless data. 

You will need to identify the transmitter and receiver channel for each antenna. Click Next > when 
finished. 

Follow Steps 8 and 9 of the Survey Wheel Controlled Collection setup. 
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Users may want to collect point data with some Static Stacking . Static Stacking is used to suppress 
random high and low frequency noise. This noise often affects data quality when files with a long time 
range are collected. The static stacking filter averages a user-selected number of scans together and 
outputs the result. For example, the user selects a value of 32 scans. The SIR 20 will collect 32 successive 
scans performing a continuous moving average and output one ‘stacked’ trace when completed. This can 
significantly improve the signal-to-noise (S/N) ration of the output signal at the cost of increased data 
collection time. 

Click the green arrow  to begin collecting data. Since you are collecting one scan at a time, you will 
need to initiate data collection after every trace. This can be done in three ways. The SIR 20 will take a 
single scan every time you click the remote marker on your antenna handle, click the green ‘Run’ arrow 
again, or push the Down arrow button on the keyboard. 

During Collection 
• You can end the survey by clicking the appropriate button on the 

collection toolbar. You can also close and save the file by holding 
down the antenna tow handle marker button for 5 seconds. 

• To collect another profile with the same settings, click the Run Project 
button (green square). 
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Chapter 3: Setting Up your System 
for 3D Data Collection 

This section presents instructions for configuring your SIR 20 to collect a block of 3D data. Data 
collection may be in GPS, belt or survey wheel mode. You should first read though the previous section 
on 2D data collection and understand basic 2D before attempting to collect 3D data. 

Collecting data for 3D imaging is easiest when you have a guide grid laid out to follow. You should lay 
out a grid with chalk, paint, ropes, or survey flags or stakes. Your grid can be any size, but your data 
quality will be much better if you make sure that your grid corners are square. Your grid itself does not 
have to be a square, it can be a rectangle, or can be irregularly shaped, If you follow the tips below, the 
pre-survey gridding process will be greatly simplified. 

Tips for Grid Setup 
• If you are scanning in a normal profile order (one direction only), you need the grid edge that you 

start your profiles from (the baseline) to be straight. We understand ‘one direction only’ to mean 
scanning along either the X or the Y axis, but not both. A ‘normal’ profile order is one where you 
are collecting data along your profile in one direction. In other words, you start at the baseline, 
collect data until the end of the line, pick up the antenna and move it back to the baseline to collect 
the next profile in the same direction. This is different from the zigzag method, where you are 
simply turning around and collecting the next data file in the opposite direction from the previous 
one. If you are collecting in a zigzag order, both the start and finish baselines should be straight. 

• Your grid can be irregular, but as long as the line that your profiles start from is straight, the 
RADAN software will have no problem creating 
parallel profiles.  

• Make sure that your grid corners are right angles 
and that your grid lines are actually perpendicular 
to your baseline. The graphic at the right 
illustrates how to put together a square, 10×10 
grid. 

1 Locate the origin point (0,0) and pull a tape 
measure 10 to find the point 10,0   
(blue line: a). This is your baseline. 

2 Pull one tape measure 10 from 0,0 (line b) to 0,10. 
Pull the other one from  
10,0 to 0,10 (line c). 

3 Move both tapes together so that 10 on line b connects to 14.14 on line c. The point that they connect 
is the grid corner. You will know that the corner at 0,0 is square because this method produces a right 
triangle. 

4 Repeat for the corner 10, 10. 
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You can use this method for grids of any size. You can also use this for rectangular grids. 

• Make sure to assign X to one axis and Y to the other.  

• Photograph or make a sketch map of the grid. 

The Three Collection Methods 
Fixed 3D Grid (recommended): This method assumes you will be collecting a square or rectangular grid 
in which profiles are all of equal length. You will need to accurately position your antenna at the start 
baseline and pull evenly spaced parallel profiles. Since you define the grid coordinates and the profiles as 
all equal length, the SIR 20 will know when to stop data collection and close each profile. Data collected 
in this mode is easier to collect and less prone to operator positioning error. 

Survey Belt with GPS: This method uses GSSI’s survey belt to maintain constant spacing between 
profiles. It is not essential for the grid to be square or for the grid corners to be at right angles since the 
GPS provides an absolute system of coordinates and the data will be correctly positioned. 

Survey Wheel: This method allows collection of irregularly shaped grids. Setup is similar to Fixed 3D 
grid, but you must manually end each file.  

Setup for Fixed 3D Grid 

1 First, create a new collection project by going to File > New or clicking the New Project button  
on the collection controls bar. This will open a window with the heading Create New Data Collection 
Project. 

 
Figure 25: File Name dialog box. 

2 Enter a project file name in the white box labeled File Name: Remember to keep the name less than 
or equal to 8 characters. Alphanumeric characters are acceptable Do not use any symbols. Click the 
button for Collect 3D Data Set. Click Next >. This will open a new window with the heading Review 
Project Information. 
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Figure 26: Project Information dialog box. 

3 Enter information to describe your project area. You can give the project a title, a location, a job 
number, a Start/Finish time and add other pertinent notes.  

• Note the gray button for Output Path. This is the location where the SIR 20 will store your data 
files. This location was set previously in View > Customize.  

• All data input fields in this menu are optional. If you do not wish to add notes, click Next >. A 
window will open with the heading Data Collection Mode (Figure 27). 

 
Figure 27: Data Collection Mode. 

4 This window gives you options of the three ways you can collect 3D radar data.  

• Note the button for Enable GPS. This allows you to collect GPS co-ordinate data along with your 
radar data. See the section on using a GPS for details on setup.  

• You should also see a button for Calibrate SW. Make sure to calibrate your survey wheel before 
you begin collection.  

• Select Fixed 3D grid and click Next > to define grid geometry. 
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5 This window allows you to set grid size and line spacing. Enter in the appropriate values for your 
survey area.  

• If you only want to collect data in one direction, leave a zero in the line spacing box of the 
direction (e.g., X or Y) that you do not want to collect. 

 
Figure 28: Grid Geometry Window. 

6 Choose your starting point and whether you want to collect data in zigzag fashion or in a single 
direction. Click Next > to go to the Configuration window. 

 
Figure 29: Configuration window. 

7 This screen controls your collection parameters. Most of the time the default settings will be 
adequate. To access settings for different applications click the small arrow in the Config Type (1) 
option.  

• You will see a broad list of application categories. Select the one that best describes your specific 
application.  

• For example, if you are scanning a concrete slab to find reinforcing bars, choose CONCRETE. 
Then choose your antenna type under Config Name (2). An X after the name is used to denote a 
cross-polarized antenna that is used 90 degrees to its normal orientation. Common data collection 
parameters will be automatically set. 
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8 Check to make sure that Scans/ft (7) is adequate for your application. The general rule is the more 
scans/unit that you collect, the slower your collection speed, the larger your data file, and the more 
stretched your file will appear. When you are finished, click Next >. 

9 The next window (Figure 30) will prompt you to either create a new macro, or attach one that you 
have already created. A macro is nothing more than a saved list of data collection parameters. These 
parameters include: filters, time range and gain settings. These will vary from job to job, so it is 
possible you will have many different macros for different survey objectives. 

 
Figure 30: Attach a Macro or Create a New One. 

• There are no pre-saved macros on the system, so if you are using your SIR 20 for the first time 
you will need to create one. Click the button for Create New Macro and click Finish. The antenna 
will initialize, you will see a clock counting a few seconds and then the following window will 
open. 

 
Figure 31: The Setup Screen. 
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10 This window will allow you to further customize your data collection parameters. The window is 
divided into two main areas.  

• The top 2/3 of the window shows the data display as O-scope and Linescan.  

• The bottom 1/3 is reserved for parameter selection pop-up windows. These parameter selection 
windows can be accessed by clicking on one of the blue and yellow collection parameter controls 
at the bottom of the screen.  

• You can also check the file header by clicking on the File Header icon.  

Position/Range     
The first collection parameter button is for Position/Range. This controls the length of the time (in 
nanoseconds) that the system will acquire data. The default vertical scale is two-way travel time. The 
larger the value that you set for time range, the longer your SIR 20 will record data. This (generally) 
translates to scanning deeper, however, total depth of penetration is a function of both the conductivity 
(σ’) and permittivity (ε’) of the media, so the range and depth are not directly equivalent.  

The Auto Position Servo and Position correction control enable the user to adjust the direct coupling 
pulse (i.e. the transmitted pulse) of the antenna to ‘zero’ time, or to adjust the direct coupling pulse up or 
down in the selected time range window. You will note that with the auto position servo ‘ON’ the 
transmitted pulse is set several nanoseconds below the top of the O-scope display.  

The Auto Position Servo automatically sets the transmitted pulse ‘down’ in the time range window 
approximately 10% of the value entered for the range e.g. if the time range is set at 50 ns, the transmitted 
pulse will be set 5 ns below ‘zero’. This is done to insure that the entire transmitted pulse is recorded. If 
this function is inadvertently turned off during system configuration, the transmitted pulse (zero time) 
may not be present in the time range window. If this occurs, the data will be useless as you will have no 
zero time reference form which to measure time/depth.  

GSSI recommends that you leave the Auto Position servo ON until you are familiar with the effects of 
moving the signal up or down in the time range window. Please note that the ‘zero’ time on the SIR 20 is 
indicated by the value of 100. This value is arbitrary and has to do with the delay time of transmit and 
receive signals within the electronics of the system. This value does NOT affect the stored value of the 
range. 

Gain    
The second button controls the Time-Variable-Gain (TVG). Gain is signal amplification used to 
compensate for the natural effects of signal attenuation. As the transmitted signal passes through a 
material, it will weaken (attenuate) as the material absorbs some signal. Gain amplifies that signal after it 
is received to compensate for signal losses and make weaker reflectors easier to see. No additional energy 
is sent out of the antenna. The Gain function operates at a number of linearly distributed points along the 
time range.  

The Auto Gain Servo automatically sets the gain of the system based upon the received signal from the 
antenna at the point where the antenna is located when the servo is enabled. At large sites it may be 
necessary to briefly scan the site to decide if the Auto Gain Servo gain values are too high or too low.  

In either case, you should adjust the gains manually. You cannot set the exact time of a gain point; 
however, you can manipulate the number of gain points so as to ‘position’ a gain point near at a particular 
time range (or a particular reflector). You can then adjust the amount of gain applied.  
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Gain should never decrease with depth. Each successive gain point should be greater than or equal to the 
previous. Be careful not to apply too much gain. This will lead to a phenomenon known as ‘clipping’. 
Clipping will limit the data and will cause you to lose valuable information and make it much more 
difficult to identify targets in the data. In addition, RADAN functions such as vertical and horizontal 
filtering, FFT filtering, Spectrum transformation and Hilbert envelope processing will not operate 
correctly on the data. If you prefer to leave the gain setting up to the SIR 20, make sure that Auto Gain 
Servo is enabled. 

 
Figure 32: Example of clipped versus acceptable data. 

Filters and Stacking     
The next three buttons control the vertical and horizontal filters, background removal and vertical (time) 
stacking filters. These are useful for reducing high and low frequency noise in the data. The background 
removal filter is extremely useful for removing antenna coupling effects (e.g., antenna ring-down) that 
generate horizontal noise bands in the data. The static stacking filter is useful for removing random high 
and low frequency noise in the data, but at the expense of a slower system recording speed.  

Referring to the icons above from left to right, the filters available during data collection are the IIR 
(Infinite Impulse Response) filter, FIR (Finite Impulse Response) filter and Static Stacking and 
Background Removal filter respectively. A detailed description of these filters is beyond the scope of this 
manual.  

If you are interested in learning more about these filters and their effects, we would refer your attention to 
a text on digital signal processing. Many of these values are antenna-specific and are set automatically for 
the antenna that you chose in Step 6. If you are using an antenna other than one listed in the configuration 
presets, you should alter the correct filter setting for the antenna being used. Consult your antenna 
documentation for the antenna filter default settings.  

There is also a listing of common antennas and their default settings at the back of this manual. Be sure to 
pay special attention to the IIR filter settings and make sure that they are correct for the antenna 
frequency you are using. If you selected an antenna in the Config Name box in Step 7, the correct settings 
have already been input into the system configuration. GSSI recommends that inexperienced users accept 
the default filter settings. 

Any changes you make to the collection parameters are automatically stored in the macro file. After you 
are satisfied with the collection parameters, click the green arrow to begin collection. You will then be 
guided through your collection by the onscreen prompts. 
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During Collection 

 
Figure 33: 3D Data Collection Screen. 

The 3D data collection window is divided into two main areas. You will see data scrolling by on the right 
hand side of the window and you can keep track of your location with the left hand side of the window. 
Prompts at the top-left of the screen will guide you through your survey.  

Note: You must pay careful attention to the prompt area while you are collecting a 3D survey. The 
SIR 20 will tell you what to do and where to go at each step of data collection. If you miss one of the 
system cues you may have to re-scan a line or the entire grid. 

1 Move cart to beginning of survey line. You will begin by clicking the Mark button on your cart or the 
down arrow icon at the bottom of the screen. The prompt area will not change after you click the 
mark button. Once the SIR 20 detects survey wheel movement, the Mark to Start field will change to 
Collect Data.  

2 Move the cart to the end of the survey line. Be careful not to move the antenna too fast. The SIR 20 
will beep if the survey wheel encoder (and the antenna) is moving too quickly. The beeping indicates 
that you are moving faster than the system can record the data. In effect you are ‘dropping’ scans 
along the profile. If this occurs, your profiles will not be the same length and the number of scans 
between your survey marks will not be consistent (i.e. they will be non-linear). Once you get to the 
end of the line, the SIR 20 will stop collecting data. The system knows the correct stop location 
because you defined the line length during setup.  

3 At the end of the line, you will see the phrase Wait for Beep appear in the prompt area. The SIR 20 is 
saving that data profile and resetting itself to accept the next profile. Once it is ready, you will see 
Mark to Start in the prompt area and the location information will be displayed for the beginning of 
the next line. 

4 Once you finish the last line, you can click the Playback icon to leave the collection program and go 
directly to processing and playback. (See: the RADAN and 3D QuickDraw software manuals for 
details on processing and imaging steps) If you want to collect another 3D section immediately, 
without first going into playback, click the Stop and Save button. Your data files are now stored in 
your output folder. To collect another area, click the Run Project button  
(green square). 
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Helpful Hint: If you need to re-collect or skip a line, use the turquoise arrows at the bottom to move to 
the correct location. Click the fifth turquoise button (not arrow-shaped) if you need to jump to a new 
location along the current profile. You will enter the new location coordinates and click Set.  

Helpful Hint: If you need to end a profile line early due to an obstacle, hold down the marker button on 
your minicart for at least five seconds. The line will close and you will be directed to the start of the next 
line. 

Setup for Survey Belt 
Survey belt data collection is for use with a GPS and GSSI’s field survey belt system. The survey belt 
consists of a two long belts with grommets and hooks every two feet. It is designed to simplify grid setup. 
Because it works in conjunction with a GPS, it is not necessary for the grid corners to be perfectly square. 
Please see the Survey Belt documentation for instructions on belt field setup. 

1 Create a new collection project by going to File > New or clicking the New Project button  on the 
collection controls bar. This will open a window with the heading Create New Data Collection 
Project. 

 
Figure 34: File Name dialog box. 

2 Enter a project file name in the white box that is labeled File Name: Remember to keep the name less 
than or equal to 8 characters. Alphanumeric characters are acceptable. Do not use symbols. Click the 
button for Collect 3D Data Set. Click Next >. This will open a new window with the heading Review 
Project Information. 

3 Enter in information to describe your project area. You can give the project a title, job number, 
start/finish time and add other pertinent notes.  

• Note the gray button for Output Path. This is the location where the SIR 20 will store your data 
files. This location was set by you in View > Customize.  

• All data input fields on this menu are optional. If you do not wish to add notes, click Next >. A 
window will open with the heading Data Collection Mode. 
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Figure 35: Project Information dialog box. 

4 This window provides you with a choice of the three ways you can collect 3D radar data.  

• Note the button for Enable GPS. You can collect GPS data along with your grid. See the section 
on using a GPS for details on setup.  

• You should also see a button for Calibrate SW. Be sure to calibrate your survey wheel before 
you begin collection. Select Survey Belt.  

 
Figure 36: Data Collection Mode. 

• After about one second, you will see the GPS information at the right side of the window become 
active. A GPS is required for Survey Belt data collection.  

• Pay special attention to the data validity information. Your SIR 20 will analyze the signal from 
the GPS and determine if the data is valid. It makes this determination based on the number of 
satellites that the GPS can see. The more satellites, the better the signal the higher the spatial 
precision of the GPS readings. 

• You cannot collect GPS data with an invalid signal. Once you have assessed the data validity, 
click Next > to define grid geometry. 
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Figure 37: Survey Belt Grid Geometry. 

5 Survey belt data collection positioning is largely automated. As a result, grid size is limited to a 
maximum of 20 meters or 48 feet. Your grids can be smaller than these dimensions, but not larger. 
You can only collect single direction profiles (along the Y axis) as opposed to bidirectional. Define 
your Y length and the spacing between your profiles and then click next to see Configuration. 

 
Figure 38: Configuration window. 

6 This screen controls your collection parameters. Most of the time the default settings will be fine. To 
access settings for different applications click the small arrow in the Config Type (1) option.  

• You will see a broad list of application categories. Choose the one that best describes your 
application.  

• For example, if you are scanning an area with a 400 MHz antenna to find underground utilities 
and storage tanks, choose UTILITY. Then choose your antenna type under Config Name (2). 
Common data collection parameters will be automatically set. 

7 Check to make sure that Scans/ft (7) is adequate for your application. The general rule is the more 
scans/unit that you collect, the slower your collection speed, the larger your data file, and the more 
stretched your file will appear. When you are finished, click Next > to open the Create New Data 
Collection Project window. 
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8 The next window (Figure 39) will prompt you to either create a new macro or attach one that you 
have already created. A macro is nothing more than a saved list of data collection parameters. These 
parameters include: filters, time range and gain settings. These will vary from job to job, so it is 
possible you will have many different macros for different situations. 

 
Figure 39: Attach a Macro or Create a New One. 

• There are no pre-saved macros on the system, so if you are using your SIR 20 for the first time 
you will need to create one. Click the button for Create New Macro and click Finish. The antenna 
will initialize, you will see a stop watch counting a few seconds and then the following window 
will pop-up: 

 
Figure 40: The Setup Screen. 

9 This window will allow you to further customize your collection parameters. The window is divided 
into two main areas.  

• The top 2/3 of the window shows the data display as O-scope and Linescan.  

• The bottom 1/3 is reserved for parameter selection pop-up windows. These parameter selection 
windows can be accessed by clicking on one of the blue and yellow collection parameter controls 
at the bottom of the screen.  

• You can also check the file header by clicking on the File Header icon.  
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Position/Range     
The first collection parameter button is for Position/Range. This controls the length of time (in 
nanoseconds) that the system will acquire data. The default vertical scale is two-way travel time. The 
larger the value that you set for time range, the longer your SIR 20 will record data. This (generally) 
translates to scanning deeper, however, total depth of penetration is a function of both the conductivity 
(σ’) and permittivity (ε’) of the media, so the range and depth are not directly equivalent.  

The Auto Position Servo and Position correction control enable the user to adjust the direct coupling 
pulse (i.e., the transmitted pulse) of the antenna to ‘zero’ time, or to adjust the direct coupling pulse up or 
down in the selected time range window. You will note that with the auto position servo ‘ON’ the 
transmitted pulse is set several nanoseconds below the top of the O-scope display.  

The Auto Position Servo automatically sets the transmitted pulse ‘down’ in the time range window 
approximately 10% of the value entered for the range e.g. if the time range is set at 50 ns, the transmitted 
pulse will be set 5 ns below ‘zero’. This is done to ensure that the entire transmitted pulse is recorded.  

If this function is inadvertently turned off during system configuration, the transmitted pulse (zero time) 
may not be present in the time range window. If this occurs, the data will be useless as you will have no 
zero time reference from which to measure time/depth.  

GSSI recommends that you leave the Auto Position servo ON until you are familiar with the effects of 
moving the signal up or down in the time range window. Please note that the ‘zero’ time on the SIR 20 is 
indicated by the value of 100. This value is arbitrary and has to do with the delay time of transmit and 
receive signals within the electronics of the system. This value does NOT affect the stored value of the 
range. 

Gain     
The second button controls the Time-Variable-Gain (TVG). Gain is artificial signal amplification used to 
compensate for the natural effects of signal attenuation. As the transmitted signal passes through a 
material, it will weaken (attenuate) as the material absorbs some signal. Gain amplifies that signal after it 
is received to compensate for signal losses and make weaker reflectors easier to see. No additional energy 
is sent out of the antenna.  

The Gain function operates at a number of linearly distributed points along the time range. The Auto Gain 
Servo automatically sets the gain of the system based upon the received signal from the antenna at the 
point where the antenna is located when the servo is enabled. At large sites it may be necessary to briefly 
scan the site to decide if the Auto Gain Servo gain values are too high or too low. In either case, you 
should adjust the gains manually. You cannot set the exact time of a gain point; however, you can 
manipulate the number of gain points so as to ‘position’ a gain point near a particular time range (or a 
particular reflector). You can then adjust the amount of gain applied.  

Gain should never decrease with depth. Each successive gain point should be greater than or equal to the 
previous. Be careful not to apply too much gain. This will lead to a phenomenon known as ‘clipping’. 
Clipping will limit the data and will cause you to lose valuable information and make it much more 
difficult to identify targets in the data. In addition, RADAN functions such as vertical and horizontal 
filtering, FFT filtering, Spectrum transformation and Hilbert envelope processing will not operate 
correctly on the data. If you prefer to leave the gain setting up to the SIR 20, make sure that Auto Gain 
Servo is enabled. 
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Figure 41: Example of clipped versus acceptable data. 

Filters and Stacking     
The next three buttons control the vertical and horizontal filters, background removal and vertical (time) 
stacking filters. These are useful for reducing high and low frequency noise in the data. The background 
removal filter is extremely useful for removing antenna coupling effects (e.g. antenna ring-down) that 
generate horizontal noise bands in the data. The static stacking filter is useful for removing random high 
and low frequency noise in the data, but at the expense of a slower system recording speed.  

Referring to the icons above from left to right, the filters available during data collection are the IIR 
(Infinite Impulse Response) filter, FIR (Finite Impulse Response) filter and Static Stacking and 
Background Removal filter respectively. A detailed description of these filters is beyond the scope of this 
manual. If you are interested in learning more about these filters and their effects, we would refer your 
attention to a text on digital signal processing.  

Many of these values are antenna-specific and are set automatically for the antenna that you chose in  
Step 6. If you are using an antenna other than one listed in the configuration presets, you should alter the 
correct filter setting for the antenna being used. Consult your antenna documentation for the antenna filter 
default settings. There is also a listing of common antennas and their default settings at the back of this 
manual. Be sure to pay special attention to the IIR filter settings and make sure that they are correct for 
the antenna frequency you are using. If you selected an antenna in the Config Name box in Step 7, the 
correct settings have already been input into the system configuration. GSSI recommends that 
inexperienced users accept the default filter settings. 

Any changes you make to the collection parameters are automatically stored in the macro file. After you 
are satisfied with the collection parameters, click the green arrow to begin collection. You will then be 
guided through your collection by the onscreen prompts. 
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During Collection 

 
Figure 42: 3D Data Collection Screen. 

The Survey Belt data collection window is divided into two main areas. You will see data scrolling on the 
right hand side of the window and you can keep track of your location with the left hand side of the 
window. Prompts at the top-left of the screen will guide you through your survey.  

Note: You must pay careful attention to the prompt area while you are collecting a 3D survey. The 
SIR 20 will tell you what to do and where to go at each step of data collection. If you miss one of the 
system cues you may have to re-scan a line or the entire grid. 

1 Move cart to the beginning of the survey line. You will begin by clicking the Mark button on your 
cart or the down arrow icon at the bottom of the screen. The prompt area will not change after you 
click the mark button. Once the SIR 20 detects survey wheel movement, the Mark to Start will change 
to Collect Data.  

2 Move the cart to the end of the survey line. Be careful not to move the antenna too fast. The SIR 20 
will beep if the survey wheel encoder (and the antenna) is moving too quickly. The beeping indicates 
that you are moving faster than the system can record the data. In effect you are ‘dropping’ scans 
along the profile. If this occurs, your profiles will not be the same length and the number of scans 
between your survey marks will not be consistent (i.e. they will be non-linear). Hold down the marker 
button on the antenna tow handle for at least five seconds to close and save the current profile. The 
SIR 20 will stop collecting data, save your current file and give you instructions in the prompt area as 
to where to go next. You will see the phrase Wait for Beep appear in the prompt area. The SIR 20 is 
saving that data profile and resetting itself to accept the next profile. Once it is ready, you will see 
Mark to Start in the prompt area and the location information will be displayed for the beginning of 
the next line. 

3 Once you finish the last line, you can click the Playback icon to leave the data collection interface and 
go directly to processing and playback. See the RADAN and 3D QuickDraw software manuals for 
details on processing and imaging steps. If you want to collect another 3D section immediately 
without first going into playback, click the Stop and Save button. Your data files are stored in your 
output folder. To collect another area, click the Run Project button (green square). 
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Helpful Hint: If you need to redo a line or skip a line, use the turquoise arrows at the bottom to move to 
the correct location. 

Helpful Hint: If you need to end a profile line early due to an obstacle, hold down the marker button on 
your minicart for at least five seconds. The line will close and you will be directed to the start of the next 
line. 

Setup for Survey Wheel 
Survey wheel data collection is for use with a GSSI survey cart or a tow-behind or antenna mounted 
survey wheel. You will need to lay out a carefully defined grid with profile lines stretching perpendicular 
to a baseline. With survey wheel controlled 3D, you will have to tell the SIR 20 when to stop collecting 
each individual file. You will do this by holding down the marker button on your antenna tow handle for 
at least 5 seconds when you reach the end of each profile line. Holding the button for more than 10 
seconds will close the data collection project. 

1 Create a new collection project by going to File > New or clicking the New Project button  on the 
collection controls bar. This will open a window with the heading Create New Data Collection 
Project. 

 
Figure 43: File Name dialog box. 

2 Enter a project file name in the white box that is labeled File Name: Remember to keep the name less 
than, or equal to 8 characters. Alphanumeric characters are acceptable. Do not use symbols. Click the 
button for Collect 3D Data Set. Click Next >. This will open a new window with the heading ‘Review 
Project Information’. 
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Figure 44: Project Information dialog box. 

3 Enter in information to describe your project area. You can give the project a title, a job number, a 
start/finish time and add pertinent notes.  

• Note the gray button for Output Path. This is the location where the SIR 20 will store your data 
files. This location was set by you in View > Customize.  

• All data input fields on this menu are optional.  

4 If you do not wish to add notes, click Next >. A window will open with the heading Data Collection 
Mode. The Data Collection Mode window provides you with a choice of the three ways you can 
collect 3D radar data.  

• Note the button for Enable GPS. You can collect GPS data along with your grid. See the section 
on using a GPS for details on setup.  

 
Figure 45: Data Collection Mode. 

• Click the Survey Wheel button to select the proper data collection mode. You should also see a 
button for Calibrate SW. You should always calibrate your survey wheel prior to a survey.  

• Once you have completed survey wheel calibration, click Next > to define grid geometry. 
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5 This window allows you to set grid size and line spacing. Enter the appropriate values for your survey 
area. If you only want to collect data in one direction, leave a zero in the line spacing box of the 
direction that you do not want to collect. If your grid is irregularly shaped, enter the length of the 
longest profile. 

 
Figure 46: Grid Geometry Window. 

6 Choose your starting point and whether you want to collect data in zigzag fashion or single direction. 
Click Next > to go to the Configuration window. 

 
Figure 47: Configuration window. 

7 This screen controls your collection parameters. Most of the time, the default settings will be fine. To 
access settings for different applications, click the small arrow in the Config Type (1) option.  

• You will see a broad list of application categories. Choose the one that best describes your 
application.  

• For example, if you are scanning a concrete slab to find reinforcing bars, choose CONCRETE. 
Then choose your antenna type under Config Name (2). An X after the name is used to denote a 
cross-polarized antenna that is used 90 degrees to its normal orientation. Common data collection 
parameters will be automatically set. 
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8 Check to make sure that Scans/ft (7) is adequate for your application. The general rule is the more 
scans/unit that you collect, the slower your collection speed, the larger your data file, and the more 
stretched your file will appear. When you are finished, click Next >. 

9 The next window (Figure 48) will prompt you to either create a new macro or attach one that you 
have already created. A macro is nothing more than a saved list of data collection parameters. These 
parameters include: filters, time range and gain settings. These will vary from job to job, so it is 
possible you will have many different macros for different situations. 

 
Figure 48: Attach a Macro or Create a New One. 

• There are no pre-saved macros on the system, so if you are using your SIR 20 for the first time 
you will need to create one. Click the button for Create New Macro and click Finish. The antenna 
will initialize, you will see a clock counting a few seconds and then the following window will 
pop-up: 

 
Figure 49: The Setup Screen. 
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10 This window will allow you to further customize your acquisition parameters. The window is divided 
into two main areas.  

• The top 2/3 of the window shows the data display as O-scope and Linescan.  

• The bottom 1/3 is reserved for parameter selection pop-up windows. These parameter selection 
windows can be accessed by clicking on one of the blue and yellow collection parameter controls 
at the bottom of the screen.  

• You can also check the file header by clicking on the File Header icon.  

Position/Range     
The first collection parameter button is for Position/Range. This controls the length of time (in 
nanoseconds) that the system will acquire data. The default vertical scale is two-way travel time. The 
larger the value that you set for time range, the longer your SIR 20 will record data. This (generally) 
translates to scanning deeper, however, total depth of penetration is a function of both the conductivity 
(σ’) and permittivity (ε’) of the media, so the range and depth are not directly equivalent.  

The Auto Position Servo and Position correction control enable the user to adjust the direct coupling 
pulse (i.e. the transmitted pulse) of the antenna to ‘zero’ time, or to adjust the direct coupling pulse up or 
down in the selected time range window. You will note that with the auto position servo ‘ON’ the 
transmitted pulse is set several nanoseconds below the top of the O-scope display.  

The Auto Position Servo automatically sets the transmitted pulse ‘down’ in the time range window 
approximately 10% of the value entered for the range e.g. if the time range is set at 50 ns, the transmitted 
pulse will be set 5 ns below ‘zero’. This is done to ensure that the entire transmitted pulse is recorded.  

If this function is inadvertently turned off during system configuration, the transmitted pulse (zero time) 
may not be present in the time range window. If this occurs, the data will be useless as you will have no 
zero time reference from which to measure time/depth.  

GSSI recommends that you leave the Auto Position servo ON until you are familiar with the effects of 
moving the signal up or down in the time range window. Please note that the ‘zero’ time on the SIR 20 is 
indicated by the value of 100. This value is arbitrary and has to do with the delay time of transmit and 
receive signals within the electronics of the system. This value does NOT affect the stored value of the 
range. 

Gain     
The second button controls the Time-Variable-Gain (TVG). Gain is signal amplification used to 
compensate for the natural effects of signal attenuation. As the transmitted signal passes through a 
material, it will weaken (attenuate) as the material absorbs some signal. Gain amplifies that signal after it 
is received to compensate for signal losses and make weaker reflectors easier to see. No additional energy 
is sent out of the antenna.  

The Gain function operates at a number of linearly distributed points along the time range. The Auto Gain 
Servo automatically sets the gain of the system based upon the received signal from the antenna at the 
point where the antenna is located when the servo is enabled. At large sites it may be necessary to briefly 
scan the site to decide if the Auto Gain Servo gain values are too high or too low. In either case, you 
should adjust the gains manually. You cannot set the exact time of a gain point; however, you can 
manipulate the number of gain points so as to ‘position’ a gain point near a particular time range (or a 
particular reflector). You can then adjust the amount of gain applied.  
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Gain should never decrease with depth. Each successive gain point should be greater than or equal to the 
previous. Be careful not to apply too much gain. This will lead to a phenomenon known as ‘clipping’. 
Clipping will limit the data and will cause you to lose valuable information and make it much more 
difficult to identify targets in the data. In addition, RADAN functions such as vertical and horizontal 
filtering, FFT filtering, Spectrum transformation and Hilbert envelope processing will not operate 
correctly on the data. If you prefer to leave the gain setting up to the SIR 20, make sure that Auto Gain 
Servo is enabled. 

 
Figure 50: Example of clipped versus acceptable data. 

Filters and Stacking     
The next three buttons control the vertical and horizontal filters, background removal and vertical (time) 
stacking filters. These are useful for reducing high and low frequency noise in the data. The background 
removal filter is extremely useful for removing antenna coupling effects (e.g. antenna ring-down) that 
generate horizontal noise bands in the data. The static stacking filter is useful for removing random high 
and low frequency noise in the data, but at the expense of a slower system recording speed.  

Referring to the icons above from left to right, the filters available during data collection are the IIR 
(Infinite Impulse Response) filter, FIR (Finite Impulse Response) filter and Static Stacking and 
Background Removal filter respectively. A detailed description of these filters is beyond the scope of this 
manual. If you are interested in learning more about these filters and their effects, we would refer your 
attention to a text on digital signal processing.  

Many of these values are antenna-specific and are set automatically for the antenna that you chose in 
Step 6. If you are using an antenna other than one listed in the configuration presets, you should alter the 
correct filter setting for the antenna being used. Consult your antenna documentation for the antenna filter 
default settings. There is also a listing of common antennas and their default settings at the back of this 
manual. Be sure to pay special attention to the IIR filter settings and make sure that they are correct for 
the antenna frequency you are using. If you selected an antenna in the Config Name box in Step 7, the 
correct settings have already been input into the system configuration. GSSI recommends that 
inexperienced users accept the default filter settings. 

Any changes you make to the collection parameters are automatically stored in the macro file. After you 
are satisfied with the collection parameters, click the green arrow to begin collection. You will then be 
guided through your collection by the onscreen prompts. 
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During Collection 

 
Figure 51: Survey 3D Data Collection Screen. 

The 3D data collection window is divided into two main areas. You will see data scrolling on the right 
hand side of the window and you can keep track of your location with the left hand side of the window. 
Prompts at the top-left of the screen will guide you through your survey.  

Note: You must pay careful attention to the prompt area while you are collecting a 3D survey. The 
SIR 20 will tell you what to do and where to go at each step of data collection. If you miss one of the 
system cues you may have to re-scan a line or the entire grid. 

1 Move cart to the beginning of the survey line. You will begin by clicking the Mark button on your 
cart or the down arrow icon at the bottom of the screen. The prompt area will not change after you 
click the mark button. Once the SIR 20 detects survey wheel movement, the Mark to Start will change 
to Collect Data.  

2 Move the cart to the end of the survey line. Be careful not to move the antenna too fast. The SIR 20 
will beep if the survey wheel encoder (and the antenna) is moving too quickly. The beeping indicates 
that you are moving faster than the system can record the data. In effect you are ‘dropping’ scans 
along the profile. If this occurs, your profiles will not be the same length and the number of scans 
between your survey marks will not be consistent (i.e. they will be non-linear). Hold down the marker 
button on the antenna tow handle for at least five seconds to close and save the current profile. The 
SIR 20 will stop collecting data, save your current file and give you instructions in the prompt area as 
to where to go next. You will see the phrase Wait for Beep appear in the prompt area. The SIR 20 is 
saving that data profile and resetting itself to accept the next profile. Once it is ready, you will see 
Mark to Start in the prompt area and the location information will be displayed for the beginning of 
the next line. 

3 Once you finish the last line, you can click the Playback icon to leave the collection program and go 
directly to processing and playback. See the RADAN and 3D QuickDraw software manuals for 
details on processing and imaging steps. If you want to collect another 3D section immediately 
without first going into playback, click the Stop and Save button. Your data files are stored in your 
output folder. To collect another area, click the Run Project button (green square). 
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Helpful Hint: If you need to redo a line or skip a line, use the turquoise arrows at the bottom to move to 
the correct location. 

Helpful Hint: If you need to end a profile line early due to an obstacle, hold down the marker button on 
your minicart for at least five seconds. The line will close and you will be directed to the start of the next 
line. 
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Chapter 4: Information for StructureScan Users 

 
Figure 52: StructureScan Programs. 

This section is for users of the SIR 20-based StructureScan Professional. It covers the operation of the 
three StructureScan data collection programs and the processing of the data from these programs. The 
StructureScan Professional package typically includes a Model 5100 (1.5 GHz) or 5100B (1.6 GHz) high-
frequency antenna, Model 614 or 615 survey minicart, and scan pads. StructureScan systems may also 
come with Model 5101 (1.0 GHz) antennas. The three modes are described briefly below. 

SS Linescan: This program is for use with the Model 3101 (900 MHz), 5100, 5101, and 5100B antennas. 
A survey minicart is required for SS Linescan. This program is designed to be used for real time location 
of targets on a slab surface. The data collected in this program is not intended for post-processing in 
RADAN. 

Structure Scan: This program is intended for use with the 5100 or 5100B antennas and the black 
rubberized scan pad (FGDATAGRID). This program is intended to collect 26 two-foot long profiles 
collected in a specific order over that scan pad. 

Optical Scan: This program is for use with a 5100B or 5101 antenna and the optical barcode equipped 
minicart. You will also need some of the barcode paper scan pads. These come in 1x1, 2x2, and 2x4 ft 
(30x30, 60x60, and 60x120 cm) sizes as well as the metric equivalents. This is the latest edition to the 
StructureScan product family and allows easier collection and collection of different size grids. 

SS Linescan 
Select the SS Linescan Mode icon on computer Desktop. Data files collected in SS Linescan are 
automatically saved to the directory: Program Files_GSSI_RADAN NT_radandat. 

Please note that data collected in Linescan mode are 8 bit, 5 scans per inch, with 3 gain points. 

Software Setup 

1 Connect your antenna and minicart to your SIR 20. Double-click the SS Linescan icon on the 
Windows desktop. The Linescan program will open up and you will see a pop-up window which says 
Initializing Data Storage.  

Note: If you see a window saying Radar Antenna Not Found, check all connections to make sure that 
the antenna is connected properly and that the SIR 20 is powered up. Just because the laptop is on 
does not mean that the SIR 20 is also receiving power. The laptop can run for a short time from its 
internal battery. 
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Figure 53: Initial SS Linescan Screen. 

• To set Project and Notes information and name the file, click  (F2) and enter desired 
information. You can also click the Set Time box to have Linescan put the laptop’s current time 
stamp on your data file. Once you are done, Click OK. 

2 Click  (F4) and select Parameters for data 
collect setup: 

• Select Concrete Type (This will 
automatically set the Dielectric Constant) If 
you know what the dielectric is (from 
previous testing), select the Custom Type 
and enter Dielectric Constant. If unknown, 
the value is pre-set for the concrete type 
selected. 

• Set Scan Depth. The computer will take 
this number and, along with the dielectric, 
figure out the time range automatically. 
Always add a few inches to your estimated 
depth. 

• Check Survey Wheel Calibration. The 
default values are 609.6 ticks/ft (2000/m) for the gray plastic minicart and 1229 ticks/ft (4032/m) 
for the blue metal minicart. If you wish to calibrate the wheel, lay out a tape measure on your 
survey surface and follow the instruction for calibration displayed on the Survey Wheel 
Calibration window. 
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Important Note: If you have a blue metal minicart and are using it with a Model 5100B or 5101 (orange 
padded bag), you must hold down the red deadman switch on your cart to continue operation. If you do 
not hold down the switch , the antenna transmitter will not turn on and you will get a flat signal. 

• Click Run to move on to the next setup screen. 

 
Figure 54: Incorrect and Correct Signal. 

3 If your scan/trace looks like the image at the left of Figure 54, you will need to reinitialize. Hold 
down the red deadman switch on the minicart’s handle and click the re-initialize button once. After a 
few seconds you will see the scan line change to the image on the right. Click the Collect Data button 

 (F8) to begin data collection. 

4 Move your minicart forward in a straight line; you will see the data appear on the screen as the 
minicart wheels turn.  

Note: Make sure the wheels of the cart are always in contact with your survey surface. Sometimes when 
collecting data over a carpeted or dirty floor, the survey wheel slips. Since your system is only collecting 
data when the wheels are turning, wheel slippage will result in gaps in your data. 

During Collection 
SS Linescan is equipped with a Backup Cursor to aid you in easily relocated objects that you see in the 
radar data. Move handcart back along survey line just collected. You will see a vertical (distance) cursor 
move as you move the handcart, enabling easy in-field feature marking.  

Note: The cursor’s location is the center of the antenna. The center is noted as a small vertical 
indentation on the side on the orange plastic antenna housing. 
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Figure 55: Linescan Collection Screen. 

Cursor coordinates are displayed in the upper left corner of display when the left mouse button is pressed. 
The distance coordinate is the position of the antenna center, the depth coordinate will change as you 
move the cursor vertically in the window. 

1 To continue data collection on the same survey line, reverse cart travel direction along survey line 
(following initial direction). Data will be collected once the handcart returns to the point where it was 
initially reversed for feature ID. 

Note: Do not move handcart from the current survey line if you wish to continue data collection 
along this line. 

Note: The position cursor is active during data collection ONLY when backup cursor is 
activated. 

2 Press Stop  to end data collection. You will be prompted to save the data file. Whether or not you 
save, the scan will remain on the screen. 

3 To begin another scan, press  (F2). A new file name can be inserted if desired.  

4 The Position & Gain servo previously set in the oscilloscope window will be used for subsequent 
files. 

5 If working on a different material, surface, or if a different depth is desired, press  (F9) to 
Initialize system and adjust settings. 
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After Collection 
The depth scale can be calibrated using a known target. If the depth of a visible target is known (slab 
thickness, rebar depth): 

If setting depth on file being collected: 

1 Close file . 

2 Press  (F8). 

3 Place cursor over the exact point with known 
depth and click left mouse button. 

4 A crosshair is inserted on the position selected. 

5 Enter known target depth in the prompt window. 
The depth scale will be recalculated and the screen 
display scale adjusted. 

6 Depth can be set in Playback mode using the same 
steps. 

Playback 
You can also Playback data that you have previous collected and saved. Files can be recalled using the 

Playback button  (F6) on the opening page of StructureScan Linescan. You will see a listing of all of 
your saved data files.  

 
 

Known target  

Crosshair over target 
with known depth 

Figure 56: Set Depth. 
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Figure 57: Playback Options. 
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Open Second File (F3) 
Two saved data files can be displayed on the screen at once.  

• Click  (F2) to open the first file (this will appear on the top). 

• Click  (F3) to open second file. 

Note: The cursor information is active in both windows. 

 

Zoom (F6) 

The Zoom button  will show the top half of the data file 
displayed. 

 

 

 

 

File Information (F10) 

The File Information button  displays the file header 
that lists file setup, filters, gain, range, position and other 
reference information. 

 

 

 

Figure 58: 
 

Figure 59: File 
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StructureScan 
StructureScan is designed for use with the Model 5100 (1.5 GHz) or Model 5100B (1.6 GHz) antenna, 
survey minicart, and black rubberized scan pad. You will need to survey each one of the 26 lines 
completely and in order. 

Setup 

1 Tape your scan pad securely to the survey surface. It is important that the pad not move or shift 
during survey. 

2 Double-click the StructureScan shortcut to launch the StructureScan program. 

3 Go to File > New to define a new data collection project. You will be asked to provide a project file 
name. Keep this name to fewer than eight characters. This will be the root name for each of your data 
files. Click Next when you are done. 

4 Define collection parameters. Choose your 
antenna type from the pull down menu at the top 
right corner of this window. StructureScan is 
only configured to work with the 1.6 GHz and 
1.5 GHz. Do not scan a pad in the cross direction 
(with the antenna turned 90 degrees in the cart). 
Choose your maximum depth of investigation 
and also your concrete type. Then click the 
Calibrate SW (survey wheel) button. 

 

 

 

 

5 You can either calibrate your survey manually or click the picture of your minicart to accept the 
default value for that particular cart. Once you are finished, click Save to close the Survey Wheel 
calibration dialog and then click finish. Your antenna will begin to initialize. 

Figure 60: Collection Parameters. 
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Figure 61: StructureScan Setup Screen. 

6 If you have a minicart with an LCD counter on it, click the red button on the counter to set it to zero 
and click the marker button on the cart handle once to set it to one. This will help you to keep track of 
your survey line location. Hold the antenna up in the air with nothing about it for  
4 feet and click the re-initialize button. Once the antenna is finished, click the green arrow to start 
collecting. 

During Collection 
StructureScan has a specially designed scan pad that works with the StructureScan post processing 
software to provide accurate location of, and depth to, features.  

1 Place grid pad over area to be scanned. 

2 Fix edges of pad to survey surface. 

3 Mark Registration Points for each corner. We 
recommend marking the 0, 0 corner with a 
different color than the other corners, or mark the 
survey surface designating direction of first 
transect collected. 

4 Align survey cart on Line 1 . The yellow line 
on the front of the encoder (gray cart) should align 
with the yellow line on the mat. If you have a blue 
cart, look for the small indentation in the front of 
the black plastic counter assembly. 

5 Press the red button on the encoder to set the number to 0 
and click the marker button to set the counter to 1. 

6 The front wheels of the survey cart should be against the outer edge of the mat. 

Figure 62: Proper position for Survey Start. 

Press marker button 
after each profile line  

Front wheels are 
aligned with edge of 

 Cart is centered 
over line 1 

Mark corner 
registration points 
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7 Collect the first line of data. 

8 The back wheels of the survey cart should be past the last line on the survey pad to complete scans.  

9 Press the marker button. The number in the encoder window should advance by 1, and a mark will be 
inserted into the data (this will be visible once you begin collecting the next line of data.) 

10 Align the antenna on Line 2  and begin collecting data again. 

Note: The marker button should be pressed ONLY ONCE AT THE END OF EACH LINE OF 
DATA COLLECTED. This is necessary for correct post-processing. 

Caution: Make sure that the survey wheels are not skidding or slipping. Do not back the cart up 
or spin the wheels in the air – any of these may cause distance errors and resulting errors in 
processing. 

11 When you have finished with the final line (Line 26 ), press the marker button to insert a mark, 
collect 2 more inches of data, enough to see the mark in the data. 

12 Close and Save a data file. Make sure not to add any extra marks. 

13 Click  (Insert) to stop data collection and Save; or 

14 Click  (Delete) to stop data collection and Delete. 

To Continue Data Collection: 2’ X 2’ Scan Pad Collection 
To collect more Grid files with the same settings as the previous setup: 

1 Hold antenna in the air with no obstructions above it. 

2 Click the Run Project button . 

3 Continue as listed above. 

4 Data files will be saved with the same Project File name as initially opened with incrementing file 
numbers. 

After Collection 
Once you have collected a pad of data, you can move on to processing and interpretation. Close the 
StructureScan collection program and get back to the Windows desktop. 

1 Open RADAN. 

2 To set data source information, select View > Customize. 

3 Directories: Source/Output folders. This is wherever you told StructureScan to collect your data. 

4 Linear Units: Unit of measurement for vertical (depth) and horizontal axes. 

5 Under View > Toolbars, make sure that the StructureScan bar is open. 
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6 Open data file. Go to File > Open and find the pad file that you collected. It will have the root name 
of your project and a number tag. All GPR data files will have the file extension .dzt. 

7 Because of StructureScan data collection settings, the display gain will initially be very weak. To 
increase the display gain to better view data: right click in data window and increase gain. 

 
Figure 63: Display Gain. 

8 Check data to make sure it has all (26) end line marks, and all (26) surface hyperbolas. 

 
Figure 64: File Description . 

9 If any end line marks are missing, see Adding and Editing Marks at the end of this section. 

10 Click StructureScan Process Data File . You will be asked to choose a radar wave velocity for the 
migration. Migration shrinks the legs of the point reflector hyperbolas enabling accurate Depth Slice 
imaging. This function will correct for Surface Position (Time 0), filter, and migrate data.  

11 Assess migration. If not satisfied with migration effect, change the Radar Wave Velocity value and 
re-run on the raw data file.  

12 Once you have the correct migration value, click the StructureScan Depth slice icon  to view a C-
Scan data display. This function is discussed in C-Scan Display of Data and Joining Grids. 



Geophysical Survey Systems, Inc. SIR® 20 
 Manual 
 

MN92-078 Rev F 61 

 
Figure 65: Migration Comparisons. 
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Fixing Missed Marks 
If you try to process your data and get an error reading: Less than 26 End of Pass Marks Found, you will 
have to edit your data and manually place the missing marks. RADAN will still ask to save the data file. 
Click cancel and return to the raw data. 

1 Right click the data file’s vertical scale bar. It is located at the left edge of your data window. Change 
the horizontal scale to scans. 

2 Scroll through your data file and find the location of the missing mark. It will be located between two 
of the surface hyperbolas that occur at the beginning and end of each scan. Write down the scan 
number that you want to tag the mark to. Any scan falling between two surface hyperbolas is fine. 

3 Go to Edit > Edit Markers to open up the markers database. After a few seconds, a spreadsheet will 
appear on the screen. Each of these rows (horizontal) represents a marker. Scroll all the way to the 
bottom of the spreadsheet and you will see an empty row with an asterisk (*) at the left edge.  

4 Type in the scan number where you want that marker to go and make sure that DistMark is checked. 
Click Apply a few times and then close that window. 

5 Re-run the processing on the data file. 

Structure Scan Optical (Optical Scan) 
Use StructureScan Optical Scan with only the 2.6 GHz, 1.6 GHz, 1.5 GHz, or 1 GHz antenna, the optical 
minicart, and the bar coded paper mats. Optical Scan will allow you to collect 3D data that can be quickly 
and easily imaged directly on the SIR 20 in RADAN. Optical Scan is best for those times when you either 
have complicated layouts or dangerous materials in the slab and you need that added confidence of seeing 
the whole picture before you cut or core.  

Setup 

1 Tape your scan pad securely to the survey surface. It 
is important that the pad not move or shift during 
survey. 

2 Double-click the Optical Scan shortcut to launch the 
Optical Scan program.  

3 Go to File > New to define a new data collection 
project. You will be asked to provide a project file 
name. Keep this name to fewer than eight 
characters. This will be the root name of the grid 
folder in which this data will be stored. Click Next 
when you are done.  

 

Figure 66: Collection Parameters. 
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4 Define collection parameters. Choose your antenna type from the pull down menu at the top right 
corner of this window. If you are scanning a grid with the antenna oriented 90 degrees to its normal 
configuration, choose one of the X antenna setups. Choose your maximum depth of investigation and 
also your concrete type. Then click the Calibrate SW (survey wheel) button. 

5 You can either calibrate your survey manually or click the picture of your minicart to accept the 
default value for that particular cart. Once you are finished, click Save to close the Survey Wheel 
calibration dialog and then click finish. Your antenna will begin to initialize. 

 
Figure 67: Optical Scan Setup Screen. 

6 Hold the antenna up in the air with nothing around the bottom of it for 4 feet and click the re-initialize 
button. Once the antenna is finished, click the green arrow to start collecting. The system will prompt 
you to scan the barcode in the corner of the paper. 

Important Note: If you have a blue metal minicart and are using it with a Model 5100B or 5101 
(orange padded bag), you must hold down the red deadman switch on your cart to continue 
operation. If you do not hold down the switch , the antenna transmitter will not turn on and you will 
get a flat signal. 

7 With the minicart aligned at the beginning of your first profile (Figure 68), press the Mark button on 
the minicart. (thumb button). The SIR 20 will beep once and you will see the wording SCAN LINE 
ID in the Prompt Area. 

8 Move the minicart slowly forward until the barcode at the beginning of the line is read. The green 
light on the minicart will flash once and the SIR 20 will beep once. 

9 Scan the line. If you are going too fast, the SIR 20 will beep to tell you. If the system has beeped, 
finish the line and scan it again.  

10 When you get to the end of the line (the center of the antenna is at the far edge of the paper pad), the 
system will beep twice to tell you that it has saved the profile. After that signal, reposition the 
minicart at the beginning of the next line, make sure you see the words MOVE CART, PRESS 
MARK, and go back to Step 7. 
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11 Once you have finished the last line, press Make 3D File button to stop data collection, save your file, 
and go directly to processing.. 

Helpful Hint: If you need to end a profile before the end of the pad, press and hold the Mark button on 
the minicart to close that profile. Collect the next profile normally. The system will write in dummy 
values for the areas you did not scan. 

After Collection 
If you clicked the Make 3D File button, then you can go directly to Step 1 below. Otherwise, make sure 
that your StructureScan toolbar is open under View > Toolbars and open your data file. 

1 Click  (StructureScan Process Data File). You will have to choose an appropriate Radar Wave 
Velocity for the Migration. Migration shrinks the legs of the point reflector hyperbolas enabling 
accurate Depth Slice imaging. This function will correct for Surface Position (Time 0), filter, and 
migrate data. . You will then have the raw data and the processed data on the screen at the same time. 
Look at what happened to the hyperbolas in the processed data (next step). 

2 Assess migration. Compare your data to Figure 65. If the velocity needs adjustment go back to the 
raw data file and re-run the processing. 

3 Once you have the correct migration value, click the StructureScan Depth slice icon  to view a 
C-Scan data display. This function is discussed in C-Scan Display of Data and Joining Grids. 

Mark corner 
registration points 

Figure 68: Pad scanning. 

Align cart with first 
survey line 
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C-Scan Display of Data and Joining Grids 
Once you are satisfied with the processing, click Depth Slice button  for the C-scan. RADAN will ask 
you how deeply you want to display. 

1 To change Parameters, right-click in Depth Slice View Window: 

• Display Gain. 

• Slice Depth: Displays the depth (and thickness) of present view 

• Slice Thickness: Change slice thickness for viewing and depth estimation 

• Maximum Depth: Change depth of data set available in view window 

2 To change Parameters, right-click in grey scale band (left side of window). 

• Color Display: Select Color Table and Color Xform (Xform different distribution of color value 
that helps enhance display).  

• Horizontal Scale: Turn Off or On. 

Helpful Hint: Try with different Color Tables and Color Transforms for best analysis of data. 
Data displayed herein is in Color Table 22. 

3 Move through Depth Slices (by clicking on arrows in Depth Slice window) and assess data.  

Note: The TOP of features is when they appear brightest (brightest blue in this window). 

 

Depth: 2.5”-3” 3”-3.5” 3.5”-4” 4”-4.5” 

 
 

 

 

Figure 69: Scrolling through depth slices. 

Beginning to hit the top of the wire 
h 

Following the mesh as it dips in the slab. 
Note overlap in 2 pieces of mesh. 
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Combining StructureScan and Optical Scan Grids  

Multiple grid pads can be combined into one large Depth Slice file.  

• Grid pads must be processed before they can 
be combined into a Super3D map. If your 
pads were all collected on the same concrete, 
make sure to process them all with the same 
velocity. 

• Grid pads must be collected with corner 
points or side connecting. 

• If corner points or sides do not connect, they 
must be on the same spatial grid as other pad 
data sets. 

Helpful Hint: Taking careful field notes and  
drawing a map of how you set up your grids 
will make creating a Super3D map much easier. 

To create a StructureScan Standard Super 3D File 

1 Click , a small window will pop up with the heading Combine Grid Files. 

2 Click the S3D Info File button and name the new Super 3D file to be created and click OK. 

3 Enter your basic grid size. This is either 12×12 or 24×24. 

4 Enter the #Y Grids and #X Grids in your survey area. 

5 Click on a Grid Cell (on the Grid Entry Map) to enter the name of the grid to insert. Make sure that 
the location you click on is the correct grid location for your data. 

6 Once all files are entered for the survey area, click OK and the program will run and a 2D file will 
open with all the data meshed and reassigned geographic coordinates for the Super 3D file. 

7 Once created, click Depth Slice . Files will be meshed together into one large area. 
Follow directions above for moving through the Depth Slice window. 

8 For further flexibility and imaging with StructureScan grid pad data files use the 3D QuickDraw 
software module. Please see the 3D QuickDraw documentation for details. 

 

All pads are in same 
grid system. 

Pads have connecting 
reference points. 

Figure 70: Grid connections. 
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Chapter 5: Using a GPS with your SIR 20 
Your SIR 20 is capable of attaching GPS coordinates to individual data profiles. This will allow you to 
place the beginning and the end of your survey lines into a larger, real-world coordinate system provided 
that you: 1) Survey in straight lines and 2) Have a GPS with sufficient accuracy for your application. 

Attaching a GPS with its own data logger, such as the G30L available from GSSI, will allow you to 
collect GPS data points with a much finer resolution. RADAN 6 will then be able to merge data files and 
show coordinates with a GPR X, Y, and Z. 

The GPS you do choose must have the following: 

1. Provide data output through a serial (RS232) port. 

2. Output data at a baud rate of 4800. 

3. Output the NMEA GGA data string. 

4. Capable of logging its own NMEA GGA info. 

Note: GSSI only supports the G30L receiver/logger. All other GPS integrations are to be performed by 
the customer. 

Attaching a GPS 
1 Plug in your GPS to the serial port on the back of the laptop and power up your GPS according to the 

manufacturer’s instructions. Set your GPS to log the NMEA GGA data string and to communicate at 
4800. If you are using the G30L, plug in the serial lead and plug in the PS2 power cord to the 
provided USB adaptor and then plug into the USB port on the laptop.  

2 Double-click the SIR 20 icon to open the collection program. Go to View > Customize SIRveyor and 
ensure that the G30D is selected or Custom if you are using another GPS. Also check the output baud 
rate. Click OK when finished. 

 
Figure 71: SIRveyor customize screen. 

3 Set up your data collection project as you normally would but be sure to click the Enable GPS button 
in the Data Collection Mode window. The SIR 20 will communicate with the GPS and after a few 
seconds you will see information appear at the right of the screen. 
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Figure 72: GPS Enable Window. 

4 If your GPS is functioning and communicating with the SIR 20, you will see location information, a 
time stamp, number of satellites detected, a measure of signal quality, and either Data Valid or 
Invalid. Your location information will not be adequate if you are tracking fewer than 4 satellites. 

5 Click Next to continue with new project setup.  

Understanding GPS 
This is a brief description of GPS. GPS information gets attached to our data two different ways. First, the 
start and end positions are stored in the header of each *.DZT file. Second, the timing for each marked 
scan is stored in a separate *.TMF file, which RADAN 6.0 and higher incorporates into its database. 

This section gives a quick GPS overview and then describes what you need to know in order to 
effectively use the SIR 20 with a GPS. 

What is it? 
GPS is a satellite navigation system (provided free by the USDoD) designed to 
provide instantaneous position, velocity and time information almost anywhere on 
the globe at any time, and in any weather. It typically provides positioning 
accuracies ranging from 3 meters (costing $150) to 1cm ($15,000). Since it needs to 
see much of the sky, it works poorly indoors, in woods and in “concrete canyons” 
like Manhattan. 

Why do I need it? 
You probably don’t! In fact for many Ground Penetration Radar applications you can just use a survey 
wheel to measure your distance and take simple notes about your start and stop locations. And since 
digging or drilling often requires more precision than 3 meters, knowing “sort of” where you are is not 
helpful.  
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However, as surveys become larger and as technologies improve, GPS can be very helpful in telling you 
where you are on a map, or what road you turned onto, or what section of the avalanche you have already 
covered, or even where you were in the middle of a lake. And of course if you actually need expensive 
survey-grade GPS accuracy, we want to give you the hooks you need to place our RADAR data correctly. 
Increasingly GPS is claiming a legitimate place in the ever increasing size and variety of GPR 
applications. 

How does it work? 
GPS works by triangulating the distance from satellites in space. Like our GPR systems, these satellites 
just measure time and the time is takes a signal to travel from point A to point B very accurately and 
estimate the distance using the speed of light. Getting the travel-time from just three satellites is enough to 
know where you are on the earth. Getting the travel-time from 12 satellites greatly decreases the 
uncertainty of your position. Typically around buildings and trees you might “see” six satellites, plenty to 
know where you are to within 3 meters. The degree of precision depends on many things, like how well 
distributed the satellites are in the sky, or the travel path the signal took to get to your receiver. 

Main sources of error: 
GPR and GPS share a lot in common. The travel times and paths are directly affected by the medium. For 
GPS, this means the signal from the satellites to your receiver can get slowed down and bent by changes 
in the Ionosphere, the Troposphere and even nearby objects. These sources of error can be reduced using 
expensive tricks like dual frequency, Klobuchar modeling and Real-Time Kinematic (RTK) solutions. 

The least expensive way to correct for these errors is through 
Differential GPS (DGPS), where data from a second stationary 
“Base” GPS is subtracted from a Roving GPS. Compared to the 
distance from the satellite, distance between Base and Rover is 
insignificant, which means the travel paths through the 
ionosphere and troposphere are basically identical. So the 
difference between the two positions subtracts out atmospheric 
effects, leaving just the Rover position. 

What is WAAS? 
The Wide Area Augmentation System (WAAS) is a form of 
differential GPS that uses geostationary satellites to transmit an 
error correction estimate back down to your receiver. The 
measured positions of ground reference stations, strategically 
positioned across the country, are sent up to the WAAS satellites. 
Your receiver reads the reference station closest to you. 

“WAAS testing in September 2002 confirmed accuracy performance of 1 – 2 meters horizontal and 2 –3 
meters vertical throughout the majority of the continental U.S. and portions of Alaska.” 
(http://gps.faa.gov/Programs/WAAS/waas.htm) This is with a clear view of the sky. Typically WAAS 
can improve your error from less than 5 meters 95% of the time to less than 3 meters. WAAS is now 
available even in the less expensive GPS units and is recommended. It is included in the G30L system 
supported by GSSI. 

http://gps.faa.gov/Programs/WAAS/waas.htm
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What is NMEA? 
The National Marine Electronics Association (NMEA, pronounced “NEE’ma”) has generated a standard 
set of messages for communicating GPS information. We use the NMEA 0183 version 2.1 protocol. 

So which one should I get? 
We have chosen to go with a GPS Data logger, mostly because it is so simple. No buttons, nothing to 
control and everything is handled automatically inside the SIR 20. Yet it produces results as good as the 
other consumer-grade, WAAS enabled units.  

However if you already have a GPS, we have tested the Garmin eTrex, GPS Map76S, Magellan SporTrak 
Pro, Teletype PocketPC GPS, and a few others. These should all work fine, but not as seamlessly. 

Our requirements are rather flexible. Any unit that sends the NMEA GGA command should work and be 
imported into RADAN, provided that the data is stored as an ASCII text file. Consult your GPS 
documentation for instructions on how to get your data into that format. Since each company sells its own 
interface, we have chosen to work with the popular shareware, OziExplorer (www.oziexplorer.com), as 
our interface. OziExplorer can talk to Garmin, Magellan, Eagle, Lowrance, Brunton/Silva and MLR units. 
It will even interface with other NMEA compatible units that output waypoints in the NMEA sentences:  

$GPRMC or  

$GPGGA and $GPVTG or  

$GPGLL and $GPVTG  

If your GPS outputs a GGA command every second in a standard serial fashion (4800 baud, 8 bit, no 
parity, 1 stop bit), and if you can get your tracklog into OziExplorer, then we can talk to your GPS with 
RADAN 6. 

Also, if you can get that NMEA GGA string to log in an ASCII text (.txt) file, RADAN can import it. 
GSSI Support cannot help you do that. Consult your GPS manufacturer or GPS documentation for that. 

Using the G30L with the SIR 20 and RADAN 6 
The G30L is now an optional accessory to our SIR 20. It is a GPS datalogger with no external controls. It 
will store up to 15 hours of GPS data that can be downloaded at any time. The only caveat is that once it 
fills its memory, it stops. For this reason, we stop and clear its internal memory at the end of each survey. 
To simplify the interface we also needed to make changes in RADAN. Here’s all you need to do. 

• Turn on your SIR 20. 

• Plug your GPS unit in the serial port and the USB port (for power) 

• Follow the steps in the Data Collection Mode window during survey setup. 

GPS Start/Stop positions and times go in the header of your DZT data file. (see Addendum A). These 
positions are all you’ll need for most surveys.  

The GPS positions between Start and Stop get matched up with the Mark positions in RADAN 6 and are 
stored in the new database (Microsoft Access compatible). 

http://www.nmea.org/
http://www.oziexplorer.com/
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Matching Your Own GPS/GPR Data  
With other GPS units, the match up can be done, but it’s a bit complicated. Here’s how. 

First Collect the GPS/GPR Data: 

• Turn on your SIR 20. 

• Plug your GPS unit in the serial port. 

• Follow the steps in the Data Collection Mode window during survey setup. 
• Set your GPS to output NMEA (the standard 0183 version 2.1) at 4800 baud. 

• Set your GPS to start logging track data.  
On the Garmin units this means going to the Track menu, turning it on and setting the track 
interval (i.e. every 2 seconds or every 10 meters.) 

• Start Data Acquisition: 

• Stop Data Acquisition and Close the file. 

GPS Start and Stop positions and times go in the header. In our header, rh_version is set to 2. (see 
Addendum A). 

So far this is not complicated at all. And since most surveys will require nothing more than these two 
begin/end positions, any standard GPS outputting GGA will do this job nicely. 

Next Time-Synchronize GPS/GPR files. 

But if the survey is along a curve, you will need to work out the GPS position of each scan. 

This can be done in Microsoft Visual Basic or with Simulink MatLab to get the two data files together. 

Our Binary file extension is *.TMF. The tracklog output of your GPS software will have a unique 
extension. (that’s why we prefer the Oziexplorer *.plt file so that all the various GPS’s can output data in 
one format). 

• For Time based data acquisition. 

Match GPS Start/Stop position/time with records in the GPS log.  
The scan rate is used to time tag individual scans. You can use the start and end system time to more 
accurately determine scan rate. 

• For Distance based data acquisition or data with user marks. 

Match GPS Start/Stop position/time and file filename.TMF to synchronize marked scans with the 
time/position records from the GPS log. Interpolate time/distance data between the marked scans as 
necessary.  

Please see the protocols listed below in the following Addenda for help on how to extract the 
necessary information.  

Note: The G30 data logger is our preferred GPS. We do not have the resources to support all the myriad 
GPS products that can be used with the SIR 20. And since we believe the header update and the *.TMF 
interface is flexible enough to meet most GPS needs, we offer this technical note as our only assistance 
for non-standard use. 



Geophysical Survey Systems, Inc. SIR® 20 
 Manual 
 

MN92-078 Rev F 72 

Addendum A 
RADAN File Header Format   (SIR 20) 

Please note: This information is being provided for informational use only. It is not supported by GSSI 
technical support and is only provided for those users who are already comfortable working in a C 
programming environment. 

A. Internal structures 

 
struct tagRFDate   //  File header  date/time structure 
{  
  unsigned sec2 : 5;  // second/2 (0-29)  
  unsigned min  : 6; // minute (0-59)  
 unsigned hour : 5; // hour (0-23)  
  unsigned day  : 5;  // day (1-31)  
  unsigned month: 4; // month (1=Jan, 2=Feb, etc.)  
  unsigned year : 7;  // year-1980 (0-127 = 1980-2107) 
      }; 
 
struct tagRFCoords   // Start/End position 
{ 
     float rh_fstart;  
     float rh_fend;  
}; 
 
struct  RGPS    // GPS record/system time SYNC 
{ 
char  RecordType[4];  // “GGA” 
DWORD    TickCount;  // CPU tick count  
double  PositionGPS[4];  // Latitude (positive if 'N'), Longitude (positive if ‘E’), 
     // Altitude,  FIXUTC 
}; 
 
 
 
B. Constants and macros 
 
// constants 
const int     MINHEADSIZE  = 1024; 
const int     PARAREASIZE  =  128; 
const int     GPSAREASIZE = 2 * sizeof(RGPS); 
const int     INFOAREASIZE (MINHEADSIZE - PARAREASIZE- GPSAREASIZE) ; 
 
// structure member alignment macros 
#define TYPEBYTE(x,n)    BYTE x##[n] 
#define SHORTBYTE(x)  TYPEBYTE(x,2)  // short int (16 bit) 
#define FLOATBYTE(x)  TYPEBYTE(x,4)  // float  
#define RFDATEBYTE(x) TYPEBYTE(x,4)  // tagRFDate 
#define COORDBYTE(x) TYPEBYTE(x,8)  // tagRFCoords 
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C. Radan Header structure 
 
struct tagRFHeader 
 {    // Offset in bytes 
   short rh_tag;   // 0x00ff if header, 0xfnff for old file      00 
   short  rh_data;   // constant 1024 (obsolete)    02 
   short  rh_nsamp;  // samples per scan    04 
   short  rh_bits;   // bits per data word (8 or 16)          06 
   short  rh_zero;   // Offset (0x80 or 0x8000 depends on rh_bits)  08 
   FLOATBYTE(rhf_sps);   // scans per second          10 
   FLOATBYTE(rhf_spm);   // scans per meter           14 
   FLOATBYTE(rhf_mpm);   // meters per mark          18 
   FLOATBYTE(rhf_position); // position (ns)           22 
   FLOATBYTE(rhf_range);  // range (ns)           26 
   short   rh_npass;   // num of passes for 2-D files          30 
   RFDATEBYTE(rhb_cdt);  // Creation date & time          32 
   RFDATEBYTE(rhb_mdt); // Last modification date & time         36 
   short  rh_rgain;  // offset to range gain function         40 
   short  rh_nrgain;  // size of range gain function         42 
   short  rh_text;   // offset to text           44 
   short  rh_ntext;  // size of text            46 
   short  rh_proc;   // offset to processing history          48 
   short  rh_nproc;  // size of processing history         50 
   short rh_nchan;  // number of channels          52 
   FLOATBYTE(rhf_epsr);  // average dielectric constant         54 
   FLOATBYTE(rhf_top);   // position in meters          58 
   FLOATBYTE(rhf_depth);  // range in meters           62 
 COORDBYTE(rh_coordX); // X coordinates     66 
   FLOATBYTE(rhf_servo_level); // gain servo level     74 
   char  reserved[3];  // reserved           78 
 BYTE rh_accomp;  // Ant Conf component    81 
   short   rh_sconfig;       // setup config number                     82 
   short rh_spp;   // scans per pass                        84 
   short rh_linenum;  // line number                            86 
 COORDBYTE(rh_coordY);  // Y coordinates     88 
 BYTE rh_lineorder:4;     //                                        96 
 BYTE rh_slicetype:4;     //                                        96 
 char  rh_dtype;  //                                          97 
   char  rh_antname[14];  // Antenna name            98 
 BYTE  rh_pass0TX:4;  // Activ Transmit mask         112 
 BYTE  rh_pass1TX:4;  // Activ Transmit mask         112 
   BYTE    rh_version:3;  // 1 – no GPS; 2 - GPS    113  
   BYTE    rh_system:5;  //  3 for SIR3000     113 
   char  rh_name[12];  // Initial File Name         114 
   short  rh_chksum;  // checksum for header         126 
   char  variable[INFOAREASIZE]; // Variable data    128 
 RGPS rh_RGPS[2];  // GPS info     944 
}; // End of tagRFHeader 
 



Geophysical Survey Systems, Inc. SIR® 20 
 Manual 
 

MN92-078 Rev F 74 

Addendum B 
Time Marks File Format   (SIR 20) 
 
A. Internal structures 

struct  RGPS     // GPS record/system time SYNC 
{ 

char  RecordType[4];  // “GGA” 
 DWORD    TickCount;  // CPU tick count  
 double  PositionGPS[4];  // Latitude (positive if 'N'),  

//Longitude (positive if ‘E’), 
      // Altitude,  FIXUTC 
}; 
struct  RDMT     // Distance mark/system time SYNC 
{ 
 DWORD   ScanNumber;   // 24 bit scan number 
 DWORD   TickCount;   // 32 bit internal clock tick count in mS 
}; 
 
B. Constants and macros 

 
// constants 
const int     GPSAREASIZE = 2 * sizeof(RGPS); 
 
C. Time Marks File (.TMF) 

 
struct  RGPS startGPSpos;   // the same as in radan file header  
struct  RDMT markTime[nMarks];  // one record for every distance or user mark 
struct  RGPS endGPSpos    // the same as in radan file header 
 
Minimum file size is GPSAREASIZE.  // Header and footer only; file has no marks 
nMarks can be calculated from file size as (FileSize – GPSAREASIZE)/ sizeof(RDMT); v 
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Appendix A: SIR 20 System Specifications 
Antennas: Records data from 1 or 2 hardware 
channels simultaneously; 1 to 4 data channels, 
selectable.  

Display Modes: Linescan and Oscilloscope.  
In linescan display, 256 color bins are used to 
represent the amplitude and polarity of the 
signal. 

Automatic System Setups: Storage of an 
unlimited number of system setup files for 
different survey conditions and/or antenna 
deployment configurations.1 

Operating Modes: Free run, survey wheel, 
point mode. 

Range Gain: Manual adjustment from -20 to 
+100 dB. Number of segments in gain curve is 
user-selectable from 1 to 8. 

Vertical Filters: Individually filter the scans in 
the time domain. Low and high Pass, Infinite 
Impulse Response (IIR),  
Finite Impulse Response (FIR), Boxcar and 
Triangular filter types are available. 

Infinite Impulse Response Filter (IIR) 

 Low Pass 2 poles 

 High Pass 2 poles 

Finite Impulse Response (FIR), Boxcar and 
Triangle 

 Low Pass up to ½ scan length 

 High Pass up to ½ scan length 

Horizontal Filters:  

 IIR 
 Stacking 1 to 16384 scans 
 Background Rem.:1 to 16384 scans 

 Static 
 Stacking 2 to 32768 scans 
 Background Removal 

 

Radar System Connectors 

♦ (2) Antenna inputs 
♦ (1) 12 VDC input power 
♦ (1) Survey wheel or DMI input 
♦ (1) Marker input 
 

Data Storage, Standard (Internal) 

40 GB 

Data Storage, Optional (External) 

Any standard PC peripheral using the PC 
parallel port, USB port, or PCMCIA port 

Mechanical 

Size: 466 mm x 395 mm x 174 mm  
(18.4 x 15.5 x 6 in) 

Weight: 10 kg (22 lbs) 

Electrical 

Antennas: Operates with any GSSI model 
antenna and can handle up to 2 antenna inputs 
simultaneously. 

Resolution: 5 picoseconds. 

Range: 2-8,000 nanoseconds full scale, 
selectable. 

Output Data Format: 8- or 16-bit, selectable. 
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Rates @ 500 KHz PRF*  
(International Systems Only) 

 Max Rate (scans/sec) 

Sample 1 ch 2 ch 

128 980 700 

256 725 475 

512 570 290 

1025 340 190 

2048 190 105 

 

Rates @ 100 KHz PRF 

 Max Rate (scans/sec) 

Sample 1 ch 2 ch 

128 450 255 

256 265 135 

512 153 78 

1025 78 39 

2048 39 19 

Input Power: 12 volts, DC nominal with 
operating range of 11-15 volts, 60 watts. 

Thermal 

Operating Temperature: -10oC to 40oC external. 

Relative Humidity: <95% non-condensing. 

Storage Temperature: -40oC to 60oC. 

Radar System Parameters2 

♦ Signal to noise ratio  > 110 dB 

♦ Dynamic range  > 110 dB 

♦ Time base accuracy .02% 
 

1Limited only by computer hard disk capacity 
2Does not include antenna figures. 

* Not all GSSI antennas can be operated at this 
high of a PRF. 
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Appendix B: The How-To’s of Field Survey 
As the old saying goes: “Garbage in, Garbage out.” The biggest single factor affecting the quality of your 
data and your ability to make decisions based on it, is the accuracy of your data collection. This appendix 
has instructions and helpful hints to get you into the habit of collecting quality data from the beginning. 
While many of these points are only relevant to data collection over the ground, as opposed to concrete 
structures, you may find this section helpful no matter what your application. 

Site Selection 
Radar is not the proper technique for every situation. If you are unable to inspect the site, have 
prospective clients send a photograph of the area. As you gain experience, you will find it easy to judge 
an area’s or an application’s suitability. In the meantime, consider the four following issues before 
deciding whether you should conduct work at an area: 

• Topography 

• Ground Cover 

• Subsurface Conditions 

• Site Accessibility 

Topography 
One of the first things you should consider about a new survey area is the topography. In the first place, 
you need to be able to physically move the antenna over the ground surface in a fairly smooth fashion. 
Areas that are full of trenches or extreme slopes are not ideal. You can still survey an area of broken 
terrain, but it may require collecting point data rather than continuous data profiles.  

Radar energy travels into the ground perpendicular to the surface. This means that if the antenna is flat on 
the ground, and level, you are reading right under the antenna. This forward-scanning of the antenna 
could lead to serious position errors. 

Ground Cover 
If your antenna is floating on top of thick grass or a layer of gravel, you may get errors in your data 
because the signal is taking too long to couple (penetrate) with the ground. When this happens, more of 
the signal than was intended bounces off of the ground surface instead of going into the ground. Always 
try to keep your antenna flat on the ground surface. The systems will have no problem penetrating 
carpeting or low grass. A good rule of thumb for the 1500 MHz is no thicker than low carpet, and for the 
400 MHz, no more than 1 inch.  
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Subsurface Conditions 
If you are working with concrete, try to make sure that the concrete has had some curing time. Three 
months is usually adequate for a standard slab on grade, while a suspended slab may cure faster. The best 
solution is to practice on slabs of different ages so that you have a first-hand feel of the way they will 
look. Concrete that is not well cured will be difficult to see into. 

Try and find out some information about the area’s soil and water content. Generally speaking, clay and 
water cause attenuation and impede penetration. Finding out the soil grain size (sand, silt, clay) will help 
you to guess the dielectric constant of the material to help you set up survey parameters and make time to 
depth estimations. If you have never worked with soils before, you should consult the US Department of 
Agriculture soils website at http://soils.usda.gov/. The site has a number of free and low cost resources 
including soil maps of most of the United States and guides to help you understand soils. 

Site Accessibility 
Simply put, can you feasibly work in the proposed area? Is the site in the middle of a dense thicket of 
trees, or is it the outside of a tall building, or a tight elevator shaft? Remember that GPR and geophysics 
depends on your ability to see contrasts in the data. The area has to be large enough for you to collect 
enough data to be able to make an interpretation. For example, if you need to survey an area in advance of 
an 18” utility trench, you want to make sure that you have some coverage over areas outside of that trench 
so you can see normal conditions. Always give yourself some elbow room. 

Targets 
The type of targets you are trying to find will govern your choice of antennas, setup parameters, or even 
the feasibility of radar for the application. There are two main criteria to consider:  

• Target Size 

• Target Composition 

Target Size 
All things being equal, antenna choice determines how deeply you are able to penetrate and the minimum 
size of the targets that you are able to see. Lower frequency antennas see deep, but the minimum target 
size that they can see is larger. Rather than focus on what each antenna can see, the table below lists the 
appropriate antenna by application and depth range. 

http://soils.usda.gov/
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Frequency Sample Applications 
Typical Max 

Depth 
Feet (meters) 

Typical Range 
(ns) 

1.5 GHz Structural Concrete, 
Roadways, Bridge Decks 

1.5 (0.5) 10-15 

1000 MHz Concrete, Shallow Soils, 
Archaeology 

3 (1) 10-20 

400 MHz Shallow Geology, Utility, 
Environmental, 
Archaeology 

12 (4) 20-100 

200 MHz Geology, Environmental 25 (8) 70-300 

100 MHz Geology, Environmental 60 (20) 300-500 

Antennas by Application 
Radar is also not a continuous measurement along a survey line. The system takes readings (scans) at a 
set spacing. If your scan spacing is too wide, you risk not hitting your target with enough scans to draw a 
recognizable hyperbola, or worse, missing the target altogether.  

Generally you need a minimum of 10 scans to draw a recognizable hyperbola. The rule of thumb is to 
have 10 scans divided by the depth of the shallowest object. So if you want to image something 10 feet 
deep, 10 scans / 10 feet = 1 scan/foot. For 5 feet, 10 scans / 5 feet = 2 scans/foot.  

For locating structural features in concrete with the 1.5 GHz antenna, we usually recommend 60/ft. For 
utility and tank location, we usually recommend 6-24/ft. While this is more than the minimum rule of 
thumb, GSSI has found these densities to work well in the widest variety of situations. 

 
The image above shows hyperbolas from objects of similar size. The hyperbolas vary in size because, due 
to the wide beam of the radar signal, a deeper target shows reflections in more scans than a shallow one. 
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Lower frequency antennas, like the 200 MHz and 400 MHz, will 
sometimes not image targets close to the surface very well. While 
not strictly a ‘dead zone’ you should be aware that it may be 
difficult (but not impossible!) to see targets in this area. As a 
general rule of thumb, this zone is equal to the spacing between 
the transmitter and receiver dipoles, but this can vary with soil 
composition. See the chart at right for a general idea. If your 
application requires you to see deep and shallow, consider 
surveying the area with two different antennas. 
 

Target Composition 
Your ability to see a target depends on the contrast between the dielectric values of the target’s material 
and the material that the radar energy was traveling through just before it hits the target. The greater the 
contrast between the dielectric values, the more visible the target is. For applications which involve 
finding metal targets like rebar, pipes, and drums, this is not a great issue because there will always be a 
great contrast. The dielectric of metals is so high that the actual number is meaningless. You will always 
have a visible contrast where metals are concerned.  

Composition can affect your ability to see things in different ways. For example, the contact between a 
dry sand (3-6) and a water table (water being 81) will be easy to image, while the contact between 
sandstone (6) and limestone (7-8) will be much more difficult. Also remember that it is the electrical 
property of the material that most governs dielectric. Even though concrete and grade are qualitatively 
very different, they are made of similar materials and react to radar energy similarly. It is usually 
extremely difficult to tell the top of grade from the bottom of the slab. You should practice trying to 
image different materials so that you can build up a body of experience. See Appendix D for a chart of the 
dielectric constants of different materials. 

Data Collection Methods: 2D vs. 3D 
Time is money. Whether you are a university-based researcher working off a grant or performing NDT 
work for pay, the faster you can get the survey done the better off you will be. Those charging by the hour 
understand the fine balance between a price that reflects a realistic estimate of how long it will take to get 
the job done, and padding the cost with unnecessary work. The point of this discussion is to get you to 
think about how much information you really need to make a decision. 

2D 
Two-dimensional data collection means that you will be collecting and interpreting single profiles of data. 
This is useful for quickly following a pipe by scanning over an area, noting the location of the pipe 
hyperbola on the ground, then moving some distance away and scanning again for the pipe. The real 
benefit of 2D data collection is speed and ease of use. Processing is certainly possible on 2D data to clean 
up the image, but most clients will only use it for visually noting the presence/absence of targets in the 
field. 2D data collection is also useful for geologic applications such as bedrock and water table mapping. 

Frequency “Hazy” Zone 
inches (cm) 

1.5 GHz 1 (2.5) 

1000 MHz 4 (10) 

400 MHz 6 (15.25) 

200 MHz 12 (30.5) 
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3D 
Collecting data for 3D imaging obviously takes more time than 2D collection. While the SIR 3000 makes 
it faster and easier than it has ever been before, it can still add significant time (and cost) to a job. It also 
requires some software processing to produce an interpretable image. These two issues may frighten some 
users away from 3D data collection, but like GPR in general, it only requires some practice to gain 
confidence. 

Three-dimensional data can be a great aid in interpretation. The question many people ask is “When do I 
use 3D?” Aside from producing a 3D map for its own sake, there are really only three main reasons: a 
complicated area, prospecting, or dangerous targets in the subsurface. A complicated area might be a city 
street with many different types of pipes running in different directions. In a situation like that, the best 
option is usually to do 3D data collection so that you are able to visually track targets as they twist and 
turn around other targets. Prospecting is mainly what those doing Archaeology will face. In this case, you 
don’t have any concrete information about the subsurface so you will need to do 3D over the area and 
look for human-made patterns that could be targets. An example of the final reason would be coring or 
cutting into an area that has live high-voltage in the floor. When the safety of your crew is at stake, the 
more information, the better. 
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Appendix C: Listing of Antenna Parameters 
The SIR 20 comes with preloaded setups to fit the system’s data collection parameters and filters to the 
most commonly used, currently available GSSI antennas. Settings for additional antennae are also 
provided below to assist you in creating a setup for an older or specialized antenna. Please note that these 
are only generalized setups, and it may be necessary to alter these to your particular situation. For 
example, deeper penetration can be set by increasing the range during setup. 

 

Dipole Spacings in Common GSSI Antennas 
 

Antenna (Model/Frequency)  Dipole Spacing Dipole to Edge of Antenna Housing 

5100B/1.6GHz 60 mm 30 mm 

5100/1.5 GHz 60 mm 30 mm 

5101/1GHz 100 mm 25 mm 

3101/900 MHz 155 mm 75 mm 

5103/400 MHz 160 mm 60 mm 

5104/270 MHz 240 mm 100 mm 

5106/200 MHz 335 mm 120 mm 

** Note that all measurements are in Millimeters and are taken from the center of the dipole ‘bowtie.’ 
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Current and Recent Antennas 

1.6 GHz (Model 5100B) 
1.6 GHz ground coupled antenna. Depth of viewing window is approximately 18 inches in concrete. 
Setting is optimized for scanning of structural features in concrete. 

Range: 12 ns, (maximum 20 ns) 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 250 MHz 
Vertical Low Pass Filter: 3000 MHz 
Scans per second: 100 
Vertical IIR High Pass N=2F=10 MHz 
Transmit Rate: 100 KHz 

1.5 GHz (Model 5100) 
1.5 GHz ground coupled antenna. Depth of viewing window is approximately 18 inches in concrete. 
Setting is optimized for scanning of structural features in concrete. 

Range: 12 ns, (maximum 20 ns) 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 250 MHz 
Vertical Low Pass Filter: 3000 MHz 
Scans per second: 100 
Vertical IIR High Pass N=2F=10 MHz 
Transmit Rate: 100 KHz 

1.0 GHz (Model 5101) 
1.0 GHz ground coupled antenna. Depth of viewing window is approximately 30 inches in concrete. 
Setting is optimized for scanning of structural features in concrete. 

Range: 20 ns, (maximum 40 ns) 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 250 MHz 
Vertical Low Pass Filter: 2250 MHz 
Scans per second: 100 
Vertical IIR High Pass N=2F=10 MHz 
Transmit Rate: 100 KHz 
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900 MHz (Model 3101D) 
900 MHz ground coupled antenna. Depth of viewing window is approximately 1 m assuming a  
dielectric constant of 5. Pulse duration is 1.1 ns. 

Range: 15 ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 2 
Vertical High Pass Filter: 225 MHz 
Vertical Low Pass Filter: 2500 MHz 
Scans per second: 64 
Transmit Rate: 100 KHz 

500-MHz (Model 3102) no longer manufactured 
500 MHz antenna. Not Model 3102 HP or 3102 DP 

Data Collection Mode: Continuous 
Range: 60ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 3 
Vertical High Pass Filter: 125 MHz 
Vertical Low Pass Filter: 1000 MHz 
Scans per second: 64 
Transmit Rate: 100 KHz 

400 MHz (Model 5103) 
400 MHz ground coupled antenna. Depth of viewing window is approximately 4m assuming a  
dielectric constant of 5. Pulse duration is 2.5 ns. 

Range: 50 ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 100 MHz 
Vertical Low Pass Filter: 800 MHz 
Scans per second: 100 
Transmit Rate: 100 KHz 
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270 MHz (Model 5104) 
270 MHz ground coupled antenna. Middle frequency antenna optimized for mid-range profiling.  

Range: 150ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 50 MHz 
Vertical Low Pass Filter: 750 MHz 
Scans per second: 100 
Transmit Rate: 100 KHz 

200 MHz (Model 5106) 
200 MHz ground coupled antenna. Lower frequency antenna optimized for mid-range profiling.  
Pulse duration is 5 ns. 

Range: 100ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 50 MHz 
Vertical Low Pass Filter: 600 MHz 
Scans per second: 100 
Transmit Rate: 100 KHz 

100 MHz (Model 3207)* 
100 MHz ground coupled antenna. Low frequency for deeper profiling. Pulse duration is 10 ns. 

Range: 500ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 25 MHz 
Vertical Low Pass Filter: 300 MHz 
Scans per second: 16 
Transmit Rate: 50 KHz 

*not available for sale in the United States 
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Parameter Listing for Older/Specialty Antennae 
The following list of antenna setups is provided to assist you in using the SIR 20 with additional antennas. 
To use this list, you must enter the correct parameters. You may wish to save any special parameters in a 
separate macro file to help you easily recall them. Some of these are no longer commercially available, 
but the system does function with all older antennas. They are designated by their center frequency, and 
in some cases a D or S which noted whether that setup is for Deep or Shallow prospecting. Please note 
that many of these antennae have a different listed transmit rate than the default one on the SIR 20. The 
transmit rate listed here is the rate that the antenna was tested and rated at. It may function correctly at a 
higher transmit rate and allow you to collect data faster, but you must pay careful attention to your data to 
decide if the antenna is functioning correctly at the different rate.  

300-Deep 
Old 300 MHz antenna.  

Data Collection Mode: Continuous 
Range: 300ns 
Samples per Scan: 1024 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 100 MHz 
Vertical Low Pass Filter: 1000 MHz 
Scans per second: 32 
Horizontal Smoothing: 5 scans 
Transmit Rate: 50 KHz 

300-Shallow 
Old 300 MHz antenna.  

Data Collection Mode: Continuous 
Range: 150ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 100 MHz 
Vertical Low Pass Filter: 1000 MHz 
Scans per second: 32 
Horizontal Smoothing: 5 scans 
Transmit Rate: 50 KHz 

120-Deep-Unshielded 
120 MHz standard antenna.  

Data Collection Mode: Continuous 
Range: 400ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 30 MHz 
Vertical Low Pass Filter: 240 MHz 
Scans per second: 32 
Horizontal Smoothing: 5 scans 
Transmit Rate: 50 KHz 

120-Shallow-Unshielded 
120 MHz standard antenna.  

Data Collection Mode: Continuous 
Range: 200ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 30 MHz 
Vertical Low Pass Filter: 240 MHz 
Scans per second: 32 
Horizontal Smoothing: 5 scans 
Transmit Rate: 50KHz 
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100 High Power 
100 MHz antenna with high power transmitter.  

Data Collection Mode: Continuous 
Range: 500ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 25 MHz 
Vertical Low Pass Filter: 200 MHz 
Scans per second: 16 
Horizontal Smoothing: 5 scans 
Transmit Rate: 12 KHz 

100 Very High Power 
100 MHz antenna with very high power 
transmitter.  

Data Collection Mode: Continuous 
Range: 500ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 25 MHz 
Vertical Low Pass Filter: 200 MHz 
Scans per second: 16 
Horizontal Smoothing: 5 scans 
Transmit Rate: 12 KHz 

Subecho 70  
70 MHz antenna with high power transmitter.  

Data Collection Mode: Continuous 
Range: 500ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 15 MHz 
Vertical Low Pass Filter: 150 MHz 
Scans per second: 16 
Horizontal Smoothing: 5 scans 
Transmit Rate: 12 KHz 

Subecho 40 
Data Collection Mode: Continuous 
Range: 1000ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 10 MHz 
Vertical Low Pass Filter: 80 MHz 
Scans per second: 32 
Transmit Rate: 12KHz 

80 MHz 
80 MHz folded bow-tie antenna. Note: The 80 
MHz antenna is unshielded. 

Data Collection Mode: Continuous 
Range: 500ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 25 MHz 
Vertical Low Pass Filter: 200 MHz 
Scans per second: 32 
Stacking: 32 scans 
Transmit Rate: 50 KHz 

MLF 120 cm 
Low Frequency antenna 1.2m length. Note: The 
MLF antennas are unshielded. 

Data Collection Mode: Point 
Range: 250ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 30 MHz 
Vertical Low Pass Filter: 160 MHz 
Scans per second: 32 
Stacking: 32 scans 
Transmit Rate: 12 KHz 
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MLF 240 cm 
Low Frequency antenna length 2.4m 

Data Collection Mode: Point 
Range: 500ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 15 MHz 
Vertical Low Pass Filter: 90 MHz 
Scans per second: 32 
Stacking: 32 scans 
Transmit Rate: 12 KHz 

MLF 360 cm 
Low Frequency antenna length 3.6m 

Data Collection Mode: Point 
Range: 750ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 10 
Vertical Low Pass Filter: 60 
Scans per second: 32 
Stacking: 32 scans 
Transmit Rate: 12 KHz 

MLF 480 cm 
Low Frequency antenna set to a length of 4.8m 

Data Collection Mode: Point 
Range: 1000ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 6  
Vertical Low Pass Filter: 40 
Scans per second: 32 
Stacking: 32 scans 
Transmit Rate: 12KHz 

MLF 600 cm 
Low Frequency antenna set to a length of 6.0m 

Data Collection Mode: Point 
Range: 1000ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 1 
Vertical Low Pass Filter: 50 
Scans per second: 32 
Stacking: 32 scans 
Transmit Rate: 12 KHz 

Borehole 120 MHz 
Borehole antenna frequency 120 MHz. Note: 
The borehole antennas are unshielded. 

Data Collection Mode: Point 
Range: 500ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 30 MHz 
Vertical Low Pass Filter: 240 MHz 
Scans per second: 32 
Stacking: 32 scans 

Transmit Rate: 50 KHz 

Borehole 300 MHz 
Borehole antenna frequency 300 MHz. 

Data Collection Mode: Point 
Range: 300ns 
Samples per Scan: 512 
Resolution: 16 bits 
Number of gain points: 5 
Vertical High Pass Filter: 38 MHz 
Vertical Low Pass Filter: 600 MHz 
Scans per second: 32 
Stacking: 32 scans 

Transmit Rate: 50 KHz 
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Appendix D: Glossary of Terms and 
Suggestions for Further Reading. 

Antenna: a paired transmitter and receiver that sends electromagnetic energy into a material and receives 
any reflections of that energy from materials in the ground. Also called a transducer. Antennae are 
commonly referred to by their center frequency value (i.e. 400MHz, 1.5Ghz). This frequency determines 
the depth of penetration and the size of the objects or layers visible. 

Attenuation: the weakening of a radar pulse as it travels through different materials.  

Center Frequency: the median transmit frequency of an antenna. The antenna will also transmit energy 
at a frequency range of 0.5-2 times its center value. For example, a 400 MHz antenna may actually 
transmit at a range from 200-800 MHz. 

Clipping: occurs when the amplitude of a reflection is greater than the maximum recordable value. The 
system disregards the true value of the reflection and writes in the maximum allowable value. Clipping 
appears in the O-Scope as signal that “goes off the scale” at the sides of the window.  

Dielectric permittivity: the capacity of a material to hold and pass an electromagnetic charge. Varies 
with a material’s composition, moisture, physical properties, porosity, and temperature. Used to calculate 
depth in GPR work. 

EM: Acronym for electro-magnetic. 

FCC: Acronym for Federal Communications Commission. The United States governmental body that 
oversees the UWB industry of which GPR is a part. 

Gain: amplifying the signal to certain section of a radar pulse in order to counteract the effects of 
attenuation and make features more visible.  

GHz: Acronym for Gigahertz. A measurement of frequency equal to one billion cycles per second. 

GPR: Acronym for Ground Penetrating Radar. 

Ground-coupling: the initial entry of a radar pulse into the ground. The antenna should be less then 
1/10 of a wavelength above the ground surface. 

Hyperbola: an inverted U. The image produced in a vertical linescan profile as the antenna is moved 
over a discrete target. The top of the target is at the peak of the first positive (white in a grayscale color 
table) wavelet. 

Interface: the surface separating materials with differing dielectric constants or conductivity values.  

KHz: Acronym for Kilohertz. A measurement of frequency equal to one thousand cycles per second. 

Linescan: commonly used method of depicting a radar profile. Linescans are produced by placing 
adjacent scans next to each other and assigning a color scheme to their amplitude values.  

Macro: a preset list of processing options that may be applied to perform repetitive functions on an entire 
dataset. Macros may be created and edited to include different functions (see RADAN manual for 
addition information). 

Mark: point inserted along a survey line manually by the operator or at preset intervals.  

MHz: Acronym for Megahertz. A measurement of frequency equal to one million cycles per second. 
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Migration: mathematical calculation used to remove outlying tails of a hyperbola and to accurately fix 
the position of a target. 

Nano-second: unit of measurement for recording the time delay between transmission of a radar pulse 
and reception of that pulse’s reflections. Equal to one one-billionth of a second. A radar pulse travels 1 
foot/ns in air. 

Noise: unwanted background interference that can obscure true data.  

Noise floor: time depth at which the noise makes target identification impossible. 

nS: see Nano-Second. 

Oscilloscope: device used to view and measure the strength and shape of energy waves. Common term 
in GPR industry for a method of data display showing actual radar wave anatomy. 

Bandband: the frequency range at which the antenna is emitting energy. It is roughly equivalent to 0.5-2 
times the center frequency. 

RAM: Acronym for random access memory. Temporary memory in which a computer stores information 
used with a running program, or temporarily stored data before it is written to a hard drive. 

Range: the total length of time (in nanoseconds) for which the control unit will record reflections. Note: 
indicates two-way travel time. 

RF: Acronym for radio frequency. 

Sample: a radar data point with two attributes: time and reflection amplitude. A third attribute, position, 
is assigned by the user. Under-sampling will produce a scan wave that does not contain enough 
information to draw a smooth curve. It may miss features. Over-sampling will produce a larger data file. 

Samples/Scan: the number of samples recorded from an individual radar scan. Commonly set to 512.  

Scan: one complete reflected wave from transmission to reception, sometimes called a trace. 

Survey wheel: wheel attached to an antenna and calibrated to record precise distances. Necessary for 
accurate data collection. 

Time-slice: a horizontal planview of amplitude values drawn from adjacent vertical profiles. The time-
slice is produced for a particular time-depth and is vital for understanding the horizontal positions of 
features in a survey area.  

Time window: the amount of time, in nano-seconds, that the control unit will count reflections from a 
particular pulse. Set by the operator. 

Transect: a line of survey data. An area is systematically surveyed by recording transects of data at a 
constant interval. The transects are then placed in their correct position relative to each other in a 
computer and horizontal time-slices are produced. 

UWB: Acronym for Ultra-Wide Band. Refers to the wide frequency band of emissions put out by a GPR 
device. 

Wiggle trace: method of GPR data display showing oscilloscope trace scans placed next to each other to 
form a profile view. Commonly used method in seismic studies. 
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Useful Websites: 

1 Geophysical Survey Systems, Inc.: 

 www.geophysical.com 

2 United States Department of Agriculture Soils Website: 

 http://soils.usda.gov/ 

3 USDA-Natural Resources Conservation Service, Ground Penetrating Radar Program: 

 http://nesoil.com/gpr/ 

4 USDA – Natural Resources Conservation Service, GPR Soil Suitability 

http://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/use/maps/?cid=nrcs142p2_053622 

5 USDA-Natural Resources Conservation Service, Web Soil Survey 

http://websoilsurvey.sc.egov.usda.gov/App/HomePage.htm 

6 North American Database of Archaeological Geophysics: 

 www.cast.uark.edu/nadag  

 

http://www.geophysical.com/
http://soils.usda.gov/
http://nesoil.com/gpr/
http://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/use/maps/?cid=nrcs142p2_053622
http://websoilsurvey.sc.egov.usda.gov/App/HomePage.htm
http://www.cast.uark.edu/nadag
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